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End-User License Agreement 

 

THIS END-USER LICENSE AGREEMENT (this 

“Agreement”) is entered into by and between 

SKF USA Inc. and/or SKF Condition Monitoring 

Center AB (hereinafter referred to collectively as 

the “Licensor”) and any person or business that 

executes this Agreement by clicking the “I agree” 

icon at the end of this Agreement or by 

accessing, using, or installing the Software 

(“Licensee” or “You”).  Licensor and Licensee 

shall be referred to collectively in this 

Agreement as the Parties. 

 

BY CLICKING THE ACCEPTANCE BUTTON OR 

ACCESSING, USING, OR INSTALLING THE 

SOFTWARE, OR ANY PART THEREOF, YOU 

EXPRESSLY AGREE TO BE BOUND BY ALL OF 

THE TERMS OF THIS AGREEMENT.  IF YOU 

DO NOT AGREE TO ALL OF THE TERMS OF 

THIS AGREEMENT, THE BUTTON INDICATING 

NON-ACCEPTANCE MUST BE SELECTED, 

AND YOU MAY NOT ACCESS, USE, OR 

INSTALL ANY PART OF THE SOFTWARE. 

 

1. DEFINITIONS 

 

(a) Derivative Works.  The Term 

“Derivative Works” shall have the 

same meaning as set forth in the U.S. 

Copyright Act, as amended from time 

to time, in title 17 of the United States 

Code. 

 

(b) Effective Date.  The term “Effective 

Date” shall mean the date on which 

Licensee assents to the terms of this 

Agreement by clicking the “I agree” 

button at the bottom of this 

Agreement. 

 

(c) Intellectual Property Rights.  The 

term Intellectual Property Rights shall 

mean all rights arising or protectable 

under the copyright, trademark, 

patent, or trade secrets laws of the 

United States or any other nation, 

including all rights associated with the 

protection of computer programs 

and/or source code. 

(d) Person.  The term “Person” shall 

mean an individual, a partnership, a 

company, a corporation, an 

association, a joint stock company, a 

trust, a joint venture, an 

unincorporated organization, or a 

governmental entity (or any 

department, agency, or political 

subdivision thereof). 

 

(e) Software.  The term “Software” shall 

mean the software application entitled 

Software for Wireless Monitoring 

System V/T, SKF @ptitude Analyst, 

SKF @ptitude Inspector, SKF @ptitude 

Observer, SKF @ptitude Decision 

Support or any other software within 

the SKF @ptitude family suite, which 

is an application developed, owned, 

marketed, and licensed by Licensor.  

The term Software shall include the 

object code of Software for Wireless 

Monitoring System V/T, SKF @ptitude 

Analyst, SKF @ptitude Inspector, SKF 

@ptitude Observer, SKF @ptitude 

Decision Support or any other object 

code within the SKF @ptitude family 

suite and any and all user manuals, or 

other technical documentation, 

authored by Licensor in connection 

with Software for Wireless Monitoring 

System V/T, SKF @ptitude Analyst, 

SKF @ptitude Inspector, SKF @ptitude 

Observer, SKF @ptitude Decision 

Support or any other software within 

the SKF @ptitude family.  The term 

“Software” includes any corrections, 

bug fixes, enhancements, releases, 

updates, upgrades, or other 

modifications, including custom 

modifications, to Software for 

Wireless Monitoring System V/T, SKF 

@ptitude Analyst, SKF @ptitude 

Inspector, SKF @ptitude Observer, 

SKF @ptitude Decision Support or any 

other software within the SKF 

@ptitude family suite and any and all 

user manuals.  The term Software 

also includes any supplemental, add-

on, or plug-in software code provided 



 

 

to Licensee in the course of receiving 

Product Support Plan services from 

Licensor.  The term Software shall not 

be construed to include the source 

code for Software for Wireless 

Monitoring System V/T, SKF @ptitude 

Analyst, SKF @ptitude Inspector, SKF 

@ptitude Observer, SKF @ptitude 

Decision Support or any other 

software within the SKF @ptitude 

family suite. 

 

2. LICENSE 

 

(a)  Grant of License.  Licensor grants 

Licensee, pursuant to the terms and 

conditions of this Agreement, a non-

exclusive, non-transferable, and 

revocable license to use the Software 

in strict accordance with the terms 

and conditions of this Agreement, 

including any concurrent use, network 

or other limitations set forth in 

subsection (b) below.  All rights not 

specifically granted by Licensor under 

this Agreement are retained by 

Licensor and withheld from Licensee. 

 

(b) Installation and Use Rights.  

Licensee shall use the Software only 

on its internal computer equipment, 

whether such equipment is owned, 

leased, or rented, at the Licensee’s 

principal business office.  The 

following paragraphs govern your 

installation and use rights with regard 

to the Software, depending on the 

type of license you have obtained from 

Licensor. 

 

(i) If you obtained a stand-alone 

license of the Software, you 

may install one (1) copy of the 

Software on one (1) computer 

residing in your principal 

business office. 

 

(ii) If you obtained a network 

license of the Software, you 

may install one (1) copy of the 

Software on as many 

networked clients 

(workstations) as authorized 

by your network license, as set 

forth more particularly in the 

applicable purchase order or 

other ordering documents 

memorializing your license 

acquisition; provided, however, 

that all network clients 

(workstations) are connected 

to a single licensed database 

residing in your principal 

business office. 

 

(iii) If you obtained a network 

license of the Software, you 

may connect to multiple 

licensed databases, you may 

install the database-dedicated 

clients up to the total number 

of networked clients acquired 

by you under the applicable 

purchase order or other 

ordering documents 

memorializing your license 

acquisition. 

 

(c) Other Conditions of Use.  Licensor 

understands and agrees that the 

Software works in conjunction and is 

compatible with database software 

licensed to you by Microsoft or 

Oracle.  Upon installation of the 

Software, the Software may detect 

an installed database software 

application from Oracle or Microsoft, 

and if so, the Software will be fully 

installed.  If no installed database 

software application from Oracle or 

Microsoft is detected, the Software 

will not install until such time as 

Licensee installs a valid and Software 

compatible copy of an Oracle 

database or a Microsoft SQL Server 

database and consents to the license 

terms of such database software 

application.  If Licensee does not 

agree to the terms of the the Oracle 

database license or the Microsoft 



 

 

SQL Server license, or if the Licensee 

fails to install such database 

software, the Software will not work.  

Licensee is responsible for 

maintaining a valid database license 

in accordance with the Oracle or 

Microsoft license agreement (which 

ever is applicable) at all times. 

 

(d) Restrictions on Use.  Licensee may 

use the Software only for its internal 

business purposes and on the 

identified equipment on which the 

Software was first installed or for 

which it is otherwise licensed; 

provided, however, that Licensee 

may temporarily use the Software on 

a back-up system in the event that 

the primary licensed system is 

inoperative or test system not used 

for production but solely for the 

purposes of testing the Software.  

Licensee may not use the Software 

for any other purpose.  Licensee shall 

not: 

 

(i)  permit any parent, 

subsidiaries, affiliated entities 

or third parties to use the 

Software; 

 

(ii) use the Software in the 

operation of a service bureau; 

 

(iii) allow access to the Software 

through any workstations 

located outside of Licensee’s 

principal business offices; 

 

(iv) rent, resell, lease, timeshare 

or lend the Software to any 

Person; 

 

(v) sublicense, assign, or transfer 

the Software or this license for 

the Software to any Person; 

 

(vi) reproduce, distribute, or 

publicly display the Software; 

 

(vii) make the Software accessible 

to any Person by any means, 

including posting on a web site 

or through other distribution 

mechanisms over the Internet; 

 

(viii) reverse assemble, 

disassemble, reverse engineer, 

reverse compile, decompile, or 

otherwise translate the 

Software or prepare 

Derivative Works based on the 

Software; 

 

(ix) place, reproduce, or make 

available the Software on 

Licensee’s computer network 

if Licensee is only authorized 

by this Agreement to operate 

the Software on a single 

workstation; 

 

(x) exceed at any given point in 

time the total number of 

network clients authorized by 

the applicable purchase order 

or ordering document to use 

or access the Software; 

 

(xi) edit or modify the Software 

except as expressly authorized 

by Licensor, including altering, 

deleting, or obscuring any 

proprietary rights notices 

embedded in or affixed to the 

Software; 

 

(xii) use the Software in any 

manner that disparages 

Licensor, Microsoft, or Oracle, 

or use the Software in a way 

that infringes the Intellectual 

Property Rights of the 

foregoing parties; or 

 

(xiii) use the Software in a manner 

that violates any federal, state, 

or local law, rule or regulation, 

or use the Software to violate 

the rights of any third party, or 



 

 

use the Software to promote 

pornography, hatred, or 

racism. 

 

(e) Copies.  Licensee, solely to enable it 

to use the Software, may make one 

archival copy of the Software’s 

computer program, provided that the 

copy shall include Licensor’s copyright 

and any other proprietary notices.  

The Software delivered by Licensor to 

Licensee and the archival copy shall 

be stored at Licensee’s principal 

business office.  If you purchased a 

network license of the Software, you 

may install one additional copy of the 

Software on your network for the 

limited purpose of testing the 

Software’s operation.  Except for the 

limited reproduction rights set forth in 

this paragraph, Licensee shall have no 

other right to copy, in whole or in part, 

the Software.  Any copy of the 

Software made by Licensee is the 

exclusive property of Licensor. 

 

(f) Modifications.  Licensee agrees that 

only Licensor shall have the right to 

alter, maintain, enhance or otherwise 

modify the Software. 

 

(g) Protection of Software.  Licensee 

agrees that it will take action by 

instruction, written agreement, or 

otherwise as appropriate with any 

person permitted access to the 

Software to enable Licensee to comply 

with its obligations hereunder.  

Licensee shall maintain records of the 

number and location of all copies of 

Software.  Licensee shall not provide, 

permit access to or use of, or 

otherwise make available any 

Software in any form without 

Licensor’s prior written agreement, 

except to Licensee’s employees for 

purposes specifically authorized by 

this Agreement.  Licensee 

understands and agrees that the 

source code for the Software is a 

valuable copyright and contains 

valuable trade secrets of Licensor.  

Licensee agrees not to discover or 

attempt to discover, or assist or 

permit any Person to discover or 

attempt to discover, by any means 

whatsoever the source code of the 

Software. 

 

(h) Licensor’s Audit Rights.  Licensor 

shall possess the right to audit 

Licensee’s use of the Software to 

determine compliance with this 

Agreement (hereinafter referred to as 

“Licensor’s Audit Rights”).  Licensor’s 

Audit Rights shall be exercised in 

accordance with the following 

paragraphs: 

 

(i) Notice of Audit.  Licensor 

shall provide Licensee with at 

least five (5) calendar days 

advance written notice of its 

intent to exercise the 

Licensor’s Audit Rights. 

 

(ii) Conduct of Audit.  The audit 

conducted by Licensor shall 

consist of a physical review of 

the computer hardware, 

software, and middleware 

operated by Licensee at its 

principal business office and 

any other office for which 

Licensor, in its sole and 

arbitrary discretion, deems an 

audit appropriate.  Licensee 

shall provide Licensor with 

unrestricted access to its 

computer hardware, software, 

and middleware in connection 

with any audit conducted by 

Licensor. 

 

(iii) Costs of Audit.  If Licensor’s 

audit uncovers a violation of 

this Agreement by Licensee, 

Licensee shall pay all costs 

and expenses incurred by 

Licensor in exercising the 



 

 

Licensor Audit Rights, 

including, without limitation, 

all attorneys’ fees and agent 

fees incurred by Licensor.  If 

Licensor concludes that no 

violation of this License 

Agreement has occurred, 

Licensor shall bear all costs 

and expenses incurred in 

exercising the Licensor Audit 

Rights.  If Licensee obstructs, 

restricts, or otherwise 

prevents Licensor from 

conducting a full and 

unrestricted audit, Licensee 

shall bear all costs and 

expenses, including attorneys’ 

fees, incurred by Licensor in 

enforcing this Section 2(h) 

before any court or judicial 

tribunal. 

 

(iv) Frequency of Audits.  

Licensor’s Audit Rights shall be 

exercised no more than two 

(2) times in any one calendar 

year.  

 

(i) Validity of Intellectual Property 

Rights.  In any action, dispute, 

controversy, or lawsuit arising out of 

or related to this Agreement, Licensee 

shall not contest the validity of 

Licensor’s Intellectual Property Rights 

related to the Software.  Licensee 

hereby agrees that it has had an 

opportunity to investigate the validity 

of Licensor’s Intellectual Property 

Rights, and acknowledges that 

Licensor’s Intellectual Property Rights 

related to the Software are valid and 

enforceable. 

 

(j) Material Terms and Conditions.  

Licensee specifically agrees that each 

of the terms and conditions of this 

Section 2 are material and that failure 

of Licensee to comply with these 

terms and conditions shall constitute 

sufficient cause for Licensor to 

terminate this Agreement and the 

license granted hereunder 

immediately and without an 

opportunity to cure.  This subsection 

2(j) shall not be construed to preclude, 

or in any way effect, a finding of 

materiality with respect to any other 

provision of this Agreement. 

 

3.   LICENSE FEE 

The applicable licensee fees will be set forth 

in the quote issued to Licensee by Licensor 

or otherwise established in the applicable 

purchase order or other ordering 

documents memorializing your license 

acquisition. 

 

4.   OWNERSHIP 

 

(a) Title.  Licensee understands and 

agrees that Licensor owns all 

Intellectual Property Rights related to 

the Software, including custom 

modifications to the Software, 

whether made by Licensor or any 

third party.  Licensee agrees that this 

Agreement effects a license, not a 

sale, of the Software and that the first 

sale doctrine, as codified in 17 U.S.C. 

§ 109, does not apply to the 

transaction effected by this 

Agreement. 

 

(b) Transfers.  Under no circumstances 

shall Licensee sell, license, sublicense, 

publish, display, distribute, assign, or 

otherwise transfer (hereinafter 

referred to collectively as a “Transfer”) 

to a third party the Software or any 

copy thereof, in whole or in part, 

without Licensor’s prior written 

consent.  Any Transfer effected in 

violation of this Section 4(b) shall be 

void ab initio and of no force or effect. 

 

5. MAINTENANCE AND SUPPORT 

Licensor may provide you with support 

services related to the Software called 

Product Support Plan (“PSP”) services.  Use 

of PSP is governed by the policies and 



 

 

programs described in the PSP literature or 

other material from Licensor’s Product 

Support Department (hereinafter referred 

to as the “PSP Policies”) that may be 

updated by Licensor from time to time. If 

you select and pay for PSP, the PSP 

Policies shall be specifically incorporated 

into this Agreement by this reference.  

Licensee acknowledges that Licensor may 

use any technical information provided by 

Licensee in the course of receiving PSP 

services for Licensor’s business purposes, 

including for product support and 

development.  Licensor will not utilize such 

technical information in a manner that 

identifies Licensee. 

 

6. CONFIDENTIAL INFORMATION 

Licensee agrees that the Software contains 

proprietary information, including trade 

secrets, know-how and confidential 

information (hereinafter referred to 

collectively as the “Confidential 

Information”), that is the exclusive property 

of Licensor.  During the period this 

Agreement is in effect and at all times after 

its termination, Licensee and its employees 

and agents shall maintain the confidentiality 

of the Confidential Information and shall not 

sell, license, publish, display, distribute, 

disclose or otherwise make available the 

Confidential Information to any Person nor 

use the Confidential Information except as 

authorized by this Agreement.  Licensee 

shall not disclose the Confidential 

Information concerning the Software, 

including any flow charts, logic diagrams, 

user manuals and screens, to persons not 

an employee of Licensee without the prior 

written consent of Licensor. 

 

7.   LIMITED WARRANTIES 

 

(a) Licensor warrants that the Software 

will perform substantially in 

accordance with its documentation for 

a period of 180 days from the date of 

shipment of the Software; provided, 

however, that the foregoing warranty 

only applies if: (i) Licensee makes 

Licensor aware of any defect with the 

Software within seven (7) days after 

the occurrence of the defect; (ii) 

Licensee has paid all amounts due 

under this Agreement; and (iii) 

Licensee has not breached any 

provision of this Agreement.  The 

foregoing warranty does not apply in 

the event that: (i) the Software and 

documentation have been subject to 

misuse, neglect, alteration, 

modification, customization, improper 

installation, and/or unauthorized 

repair; (ii) the Software or any 

associated software or equipment 

have not been properly maintained in 

accordance with applicable 

specifications and industry standards 

or have been maintained in unsuitable 

environmental conditions; or (iii) 

Licensee has used the Software in 

conjunction with other equipment, 

hardware, software, or other 

technology that created an adverse 

impact on the operation, functioning, 

or performance of the Software. 

 

(b) EXCEPT AS SET FORTH IN THIS 

SECTION 7 AND TO THE EXTENT 

PERMITTED BY APPLICABLE LAW, 

ALL EXPRESS AND/OR IMPLIED 

WARRANTIES OR CONDITIONS, 

INCLUDING BUT NOT LIMITED TO 

IMPLIED WARRANTIES OR 

CONDITIONS OF MERCHANTABILITY, 

MERCHANTABILITY OF A COMPUTER 

PROGRAM, INFORMATIONAL 

CONTENT, SYSTEM INTEGRATION, 

FITNESS FOR A PARTICULAR 

PURPOSE, AND NON-

INFRINGEMENT, ARE HEREBY 

DISCLAIMED AND EXCLUDED BY 

LICENSOR. 

 

(c) The remedies set forth in this Section 

7 are the exclusive remedies available 

to Licensee for any problem in the 

performance of the Software. 

 



 

 

8.   LIMITATIONS ON LIABILITY 

 

(a) Limitations and Exclusions.  IN NO 

EVENT WILL LICENSOR BE LIABLE 

TO LICENSEE FOR ANY DIRECT, 

INDIRECT, INCIDENTAL, 

CONSEQUENTIAL, PUNITIVE OR 

OTHER SPECIAL DAMAGES, LOST 

PROFITS, OR LOSS OF INFORMATION 

SUFFERED BY LICENSEE ARISING 

OUT OF OR RELATED TO THIS 

AGREEMENT OR THE USE OF THE 

SOFTWARE, FOR ALL CAUSES OF 

ACTION OF ANY KIND (INCLUDING 

TORT, CONTRACT, NEGLIGENCE, 

STRICT LIABILITY, BREACH OF 

WARRANTY OR CONDITION, AND 

STATUTORY) EVEN IF LICENSOR HAS 

BEEN ADVISED OF THE POSSIBILITY 

OF SUCH DAMAGES.  THE 

PRECEDING EXCLUSION AND 

DISCLAIMER OF DAMAGES SHALL 

APPLY TO ALL CLAIMS MADE BY 

LICENSEE RELATED TO OR ARISING 

OUT OF LICENSEE’s USE OF THE 

SOFTWARE, INCLUDING, BUT NOT 

LIMITED TO, CLAIMS ALLEGING THAT 

THE SOFTWARE, OR ANY 

COMPONENT THEREOF, FAILED OF 

ITS ESSENTIAL PURPOSE OR FAILED 

IN SOME OTHER RESPECT. 

 

(b) Acknowledgment.  Licensee agrees 

that the limitations of liability and 

disclaimers of warranty set forth in 

this Agreement will apply regardless 

of whether Licensor has tendered 

delivery of the Software or Licensee 

has accepted the Software.  Licensee 

acknowledges that Licensor has set its 

prices and entered into this 

Agreement in reliance on the 

disclaimers of warranty and the 

limitations and exclusions of liability 

set forth in this Agreement and that 

the same form an essential basis of 

the bargain between the Parties. 

 

9.   TERM AND TERMINATION 

 

(a) Term.  This Agreement shall 

commence on the Effective Date and 

shall continue in existence until it is 

terminated in accordance with Section 

9(b) below. 

 

(b) Termination.  Licensor may 

terminate this Agreement and the 

license conveyed hereunder in the 

event that Licensee breaches any 

provision, term, condition, or 

limitation set forth in this Agreement, 

including but not limited to the license 

restrictions set forth in Section 2(d) of 

this Agreement. 

 

(c) Effect of Termination.  Within ten 

(10) days after termination of this 

Agreement and the license granted 

hereunder, Licensee shall return to 

Licensor, at Licensee’s expense, the 

Software and all copies thereof, and 

deliver to Licensor a certification, in 

writing signed by an officer of 

Licensee, that all copies of the 

Software have been returned to 

Licensor and that Licensee has 

discontinued its use of the Software. 

 

10. ASSIGNMENT 

 Licensee shall not assign or otherwise 

transfer the Software or this Agreement to 

anyone, including any parent, subsidiaries, 

affiliated entities or third Parties, or as 

part of the sale of any portion of its 

business, or pursuant to any merger, 

consolidation or reorganization, without 

Licensor’s prior written consent.  Any 

assignment or transfer effected in violation 

of this Section 10 shall be void ab initio 

and of no force or effect. 

 

11. FORCE MAJEURE 

 Neither party shall be in default or 

otherwise liable for any delay in or failure 

of its performance under this Agreement if 

such delay or failure arises by any reason 

beyond its reasonable control, including 



 

 

any act of God, any acts of the common 

enemy, the elements, earthquakes, floods, 

fires, epidemics, riots, failures or delay in 

transportation or  communications; 

provided, however, that lack of funds shall 

not be deemed to be a reason beyond a 

party’s reasonable control.  The Parties 

will promptly inform and consult with each 

other as to any of the above causes that in 

their judgment may or could be the cause 

of a delay in the performance of this 

Agreement. 

 

12. NOTICES 

 All notices under this Agreement are to be 

delivered by depositing the notice in the 

mail, using registered mail, return receipt 

requested, to the party’s last known 

principal business address or to any other 

address as the party may designate by 

providing notice.  The notice shall be 

deemed delivered four (4) days after the 

notice’s deposit in the mail, if such notice 

has been sent by registered mail. 

 

13. CHOICE OF LAW 

 This Agreement (including all Exhibits), 

including its formation, execution, 

interpretation, and performance, and the 

rights and obligations of the Parties 

hereunder, shall be governed by and 

construed in accordance with the laws of 

the Commonwealth of Pennsylvania, 

without regard to any conflicts of law (or 

choice of law) principles thereof. 

 

14. CONSENT TO JURISDICTION 

 In the event that either party initiates 

litigation relating to or arising out of this 

Agreement, Licensor and Licensee 

irrevocably submit to the exclusive 

jurisdiction of the state or federal court in 

or for Philadelphia, Pennsylvania for the 

purposes of any suit, action or other 

proceeding relating to arising out of this 

Agreement or any transaction 

contemplated hereby or thereby (“Legal 

Proceedings”).  Licensee further agree that 

service of any process, summons, notice, 

or document by U.S. registered mail to 

such Party’s respective address shall be 

effective service of process for any Legal 

Proceeding.  Licensor and Licensee 

irrevocably and unconditionally waive any 

objection to personal jurisdiction and/or 

the laying of venue of any Legal 

Proceeding in the state or federal court in 

or for Philadelphia, Pennsylvania, and 

hereby further irrevocably and 

unconditionally agree not to plead, argue, 

or claim in any such court that any Legal 

Proceeding brought in any such court has 

been brought in an inconvenient forum 

and otherwise waive any and all objections 

to the forum. 

 

15. EXPORT CONTROLS 

 Licensee shall not export or reexport, 

directly or indirectly, the Software without 

complying with the export controls 

imposed by the United States Export 

Administration Act of 1979, as amended 

(or any future U.S. export control 

legislation) and the regulations 

promulgated thereunder.  

 

16. GOVERNMENT END USERS 

 If Licensee is acquiring the Software for or 

on behalf of a subdivision of the U.S. 

federal government, this Section 16 shall 

apply.  The Software was developed 

completely at private expense, is existing 

computer software, is a trade secret for all 

purposes of the Freedom of Information 

Act, is “restricted computer software” and 

in all respects proprietary data belonging 

solely to Licensor, and all rights are 

reserved under the copyright laws of the 

United States.  Use, duplication, or 

disclosure by the Government is subject to 

restricted rights as set forth in 

subparagraphs (a) through (d) of the 

Commercial Computer Software Restricted 

Rights clause at FAR 52.227-19, or for 

DoD units, the restrictions as set forth in 

subparagraph (c)(1)(ii) of the Rights in 

Technical Data and Computer Software 

clause at DFARS 252.227-7013. 

 



 

 

17. TRADEMARKS 

 Licensee agrees that SKF @ptitude 

Analyst, SKF @ptitude Inspector, SKF 

@ptitude Observer, SKF @ptitude Decision 

Support or any other software within the 

SKF @ptitude family suite and the trade 

dress, logos and other designations of 

source used by Licensor to identify the 

Software are trademarks or registered 

trademarks of Licensor.  Licensee shall not 

use Licensor’s trademarks or service 

marks without the prior written consent of 

Licensor.  If the Software contains any 

active links to web sites, you agree to 

maintain such active links and not redirect 

or modify them. 

 

18. GENERAL PROVISIONS 

 

(a)  Complete Agreement.  The Parties 

agree that this Agreement is the 

complete and exclusive statement of 

the agreement between the Parties, 

which supersedes and merges all 

prior proposals, understandings and 

all other agreements, oral or written, 

between the Parties relating to the 

use of the Software. 

 

(b) Amendment.  This Agreement may 

not be modified, altered or amended 

except by written instrument duly 

executed by both Parties.  Any 

purchase orders or other ordering 

documents issued to Licensee by 

Licensor shall not have the effect of 

amending or modifying this 

Agreement, and shall only serve to 

memorialize the number of licenses 

or products ordered by Licensee.  In 

the event of a conflict between the 

PSP Policies and this Agreement, the 

terms of this Agreement shall 

control. 

 

(c) Waiver.  The waiver or failure of 

either party to exercise in any respect 

any right provided for in this 

Agreement shall not be deemed a 

waiver of any further right under this 

Agreement. 

 

(d) Severability.  If any provision of this 

Agreement is invalid, illegal or 

unenforceable under any applicable 

statute or rule of law, it is to that 

extent to be deemed omitted.  The 

remainder of the Agreement shall be 

valid and enforceable to the 

maximum extent possible. 

 

(e) Read and Understood.  Each party 

acknowledges that it has read and 

understands this Agreement and 

agrees to be bound by its terms. 

 

(f) Limitations Period.  No action 

arising under, or related to, this 

Agreement, may be brought by 

either party against the other more 

than two (2) years after the cause of 

action accrues, unless the cause of 

action involves death or personal 

injury. 

 

(g) Attorneys’ Fees.  In the event any 

litigation is brought by either party in 

connection with this Agreement, the 

prevailing party in such litigation will 

be entitled to recover from the other 

party all the costs, reasonable 

attorneys’ fees, and other expenses 

incurred by such prevailing party in 

the litigation. 

 

(h) Authorized Representative.  The 

person installing or using the 

Software on behalf of Licensee 

represents and warrants that he or 

she is legally authorized to bind 

Licensee and commit Licensee to the 

terms of this Agreement. 

 

(i) Injunctive Relief.  Licensee agrees 

that Licensor may suffer irreparable 

harm as a result of a violation of 

Sections 2, 4, 6, 10, 15, and 17 of 

this Agreement and that monetary 

damages in such event would be 



 

 

substantial and inadequate to 

compensate Licensor.  Consequently, 

Licensor shall be entitled to seek and 

obtain, in addition to such other 

monetary relief as may be 

recoverable at law or in equity, such 

injunctive other equitable relief as 

may be necessary to restrain any 

threatened, continuing, or further 

breach by Licensee without showing 

or proving actual damages sustained 

by Licensor and without posting a 

bond. 

 

CM-F0176 (Revision F, January 2011) 
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Introduction to SKF @ptitude Analyst 

About This Manual 

As you'll soon realize, SKF @ptitude Analyst is easy to install and use.  Chances are, after 

reading what you need to know in order to get going, you won't use this manual except as 

a quick reference aid. 

 In writing this manual we assume you are familiar with common 

Windows operations.  Refer to your Windows guides for 

information in these areas. 

The user manuals overview @ptitude Analyst software operations, including creating 

your @ptitude Analyst machinery hierarchy of measurement POINTs, downloading and 

uploading measurements between @ptitude Analyst and your data collection device, 

and generating graphic plots and reports for analyzing the measured machinery's 

condition.  As you use this manual, you'll discover certain conventions used: 

Bold type is used to indicate text that appears in a SKF @ptitude Analyst menu, 

window, or dialog. 

Italics are used to emphasize important information. 

 - are used to indicate notes to the reader. 

Step-by-step procedures are sequenced using bullets, •. 

Understanding the @ptitude Analyst User Manual System 

The @ptitude Analyst User Manual system consists of an introduction and three 

product-specific manuals that allow you to quickly locate information specific to your 

SKF data acquisition device(s).  The User Manual system is organized with global 

@ptitude Analyst information in this introductory manual, followed by detailed product-

specific information in the corresponding product manuals.  Depending on the 

product(s) you have purchased, one or all of these additional manuals may be applicable 

to your installation.  

@ptitude Analyst Manual Overview 

SKF @ptitude Analyst Introduction and Global Features introduces SKF @ptitude 

Analyst software, and overviews general software procedures. It provides the basics on 

getting around in @ptitude Analyst applications, and describes how to set up users and 

preferences.  In addition, it documents global applications that are independent of any 

data collection method (e.g., @ptitude Home application launcher, Import and Export, 

@ptitude Analyst Monitor, Event Log, etc.). 

Chapter 1, Introduction 

Chapter 2, Getting Around in SKF @ptitude Analyst 

Chapter 3, SKF @ptitude Analyst Monitor Application 
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Appendix A, @ptitude Analyst Import / Export Features 

Appendix B, XML Export and Import 

Appendix C, @ptitude Analyst Keyboard Support 

Appendix D, Plot Icons and Hot Keys 

SKF @ptitude Analyst for SKF Microlog Analyzer applies only to the Microlog portion 

of the software.   

Chapter 1, Introduction to SKF @ptitude Analyst for SKF Microlog Analyzer 

Chapter 2, Working With Your @ptitude Analyst Database  

Chapter 3, Data Collection ROUTEs and Other Data Transfer Operations  

Chapter 4, Displaying Graphic Plots  

Chapter 5, Generating and Printing @ptitude Analyst Reports  

Appendix A, @ptitude Analyst Toolbars  

SKF @ptitude Inspector applies only to the Microlog Inspector / MARLIN portion of the 

software. 

Chapter 1, Introduction to SKF @ptitude Inspector 

Chapter 2, Working With Your SKF @ptitude Inspector Database  

Chapter 3, Data Collection ROUTEs and Other Data Transfer Operations  

Chapter 4, Displaying Graphic Plots  

Chapter 5, Generating and Printing @ptitude Inspector Reports  

Appendix A, @ptitude Inspector Toolbars  

SKF @ptitude Analyst and Multilog On-line Systems applies only the WMx, IMx, and 

DMx portion of the software. 

Chapter 1, Introduction  

Chapter 2, Setting Up Your WMx Device 

Chapter 3, Working With Your @ptitude Analyst Hierarchy  

Chapter 4, Data Collection ROUTEs and Other Data Transfer Operations 

Chapter 5, Displaying Graphic Plots 

Chapter 6, Generating and Printing SKF @ptitude Analyst Reports 

Chapter 7, Multilog DMx Machine Monitoring Module 

Chapter 8, DMx Transient Data 

Appendix A, SKF @ptitude Analyst Toolbars  

Appendix B, Event Log Redirection  

Appendix C, Data Collection Gating 
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@ptitude Analyst Introduction and Global Features Chapter Overview 

Chapter 1, Introduction - Introduces manual conventions and overviews the SKF 

@ptitude Analyst System. 

Chapter 2, Getting Around in SKF @ptitude Analyst - Introduces @ptitude Analyst 

conventions (main screens, terminology, menus, and toolbar buttons), reviews standard 

Windows operations, introduces the hierarchy list, and discusses hierarchy list 

procedures in detail. 

Chapter 3, SKF Machine Monitor Application - Describes the Monitor support 

application’s continuous measurement operation capabilities, continuous and scheduled 

mode, archive procedures, and how to set Monitor preferences. 

Appendix A, SKF @ptitude Analyst Import / Export Features - Describes database 

and bearing file import procedure, and importing and exporting @ptitude Analyst data. 

Appendix B, XML Export and Import – Details the procedure for sharing data with 

other applications via export to and import from external XML files. 

Appendix C, SKF @ptitude Analyst Keyboard Support – Provides an overview of 

@ptitude Analyst 's available keyboard operations. 

Appendix D, Plot Icons and Hot Keys – Provides a table of the hot keys and actions 

related to plots and overlays. 

Technical Support  

If you have questions regarding the installation or operation of SKF @ptitude Analyst, 

please visit the self-help portal before contacting the help desk to see if the answer is 

already published:  

Technical Support Self-help Portal: www.skf.com/cm/tsg  

If further assistance is needed, please submit a support request by clicking on the 

SUPPORT tab and one of our support engineers will contact you shortly.  

The technical support team can be reached during normal business hours (7:00 a.m. to 

4:00 p.m. local time) by phone, e-mail, or live chat:  

 Customers in Europe, Middle East and Africa:  

Phone: +46 31 337 6500  

E-Mail: TSG-EMEA@skf.com  

Chat: www.skf.com/cm/tsg  

 Customers in all other locations:  

Phone: 1-858-496-3627 or toll-free (USA) 1-800-523-7514  

E-Mail: TSG-Americas@skf.com   

Chat: www.skf.com/cm/tsg  

Note: Standard technical support will be provided at no cost on products or software 

covered under an SKF Product Support Plan (PSP), whenever applicable.  Many SKF 

Machine Health products include limited technical support for the first 180 days after 

purchase.  Support obtained after 180 days or without PSP coverage will be subject to a 

per-incident fee. Contact the technical support team for more information. 

http://www.skf.com/cm/tsg
mailto:TSG-EMEA@skf.com
http://www.skf.com/cm/tsg
mailto:TSG-Americas@skf.com
http://www.skf.com/cm/tsg
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The Host Computer 

The host computer has Microsoft Windows 7, 8.1 or 10, an Intel 2.0 GHz, 32 or 64-bit, 

or better processor, 6 or more Gbytes of RAM, and a 30 Gbyte hard disk (minimum 10 

Gbyte); and enough free disk space to store your @ptitude Analyst for On-Line Systems 

measurement Hierarchy (whose size depends on the number of monitored 

measurement POINTs).  Together, the host computer and @ptitude Analyst software 

perform database management, trending, display, and reporting functions for the DAD 

System. 

For further details, refer to the SKF @ptitude Analyst Installation Manual (P/N 

32312400). 
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Getting Around in SKF @ptitude Analyst 

Starting SKF @ptitude Analyst 

To start SKF @ptitude Analyst: 

 Select the Windows’ Start menu’s SKF @ptitude Monitoring Suite group. 

 Select SKF @ptitude Analyst. 

@ptitude Analyst starts up, and prompts you to log in. 

 Enter your user name and password. 

 Click the OK button.  The @ptitude Analyst main window displays, with the 

hierarchy visible. 

Initial Log In 

After most @ptitude Monitoring Suite applications have been installed, you will need to 

set up user names and access levels.  Two initial user names and passwords are 

provided for the initial log in when you run most application for the first time. 

 Passwords are case-sensitive. 

1. 

User name: ADMIN 

Password: skf 

User name “ADMIN” has administrative access rights. 

2. 

User name: USER1 

Password: user1 

User name “USER1” has Analyst access rights. 

Refer to the Administrative Setup section later in this chapter for more information on 

user names, passwords, and access levels.  

Login Status 

To monitor all users currently logged into a @ptitude Analyst application, use the 

Database Account Statistics dialog. 

 The Database Account Statistics dialog and Status buttons are 

for multi-user configurations only, and are not available on 

@ptitude Analyst systems with single user configuration. 
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 Press the User Login dialog’s Status button to display the Database Account 

Statistics dialog.   

 The dialog automatically displays if the maximum number of 

users allowed by your license are already logged in. 

Database Account Statistics columns include: 

Database account – Displays the Oracle database account name. 

User logged in – Displays the logged in user name. 

Computer name – Displays the computer name from which the user is logged in. 

Security 

The Help menu's About option provides a Security tab that displays the current user's 

name, access level, and that access level’s default base level. 

Hierarchy Window Overview 

 

Figure 2 - 1. 

The @ptitude Analyst Hierarchy Window. 

 size bar 

 window frame 

Main window components and basic operations are described below.  The following 

general information applies to all @ptitude Analyst applications. 
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Title Bar 

Identifies the @ptitude Analyst application, user name, and current database. 

 To move a window or dialog, drag its title bar to a new position. 

 Control Menu Box 

Click on the Control Menu box at the left of the title bar to display the Control Menu.  

The Control Menu provides options for keyboard control of the window's dimensions 

and placement (because of the mouse's ease of use, keyboard controls are rarely 

used).   

Minimize / Maximize / Restore Buttons  

 Minimize Button 

Click on the minimize button to shrink the active window to icon size on the task bar.  

A minimized window is not closed (exited), it is merely shrunk to create more room in 

the Main window.  Click on the minimized window's icon to restore the minimized 

window to its original size. 

 Maximize Button 

Click on the maximize button to enlarge the window to full-screen size.  Once 

maximized, the window's maximize button changes to a restore button. 

 Tip: Always maximize the Main window. 

 Restore Button 

Displays for maximized windows only.  Click on the restore button to restore the 

maximized window to its original size (the size it was before it was maximized). 

Menu Bar 

Displays the names of @ptitude Analyst’s drop-down menus.  Click on a menu name to 

display its drop-down menu.  Click on a menu option to select it. 

 

Figure 2 - 2. 

@ptitude Analyst’s Menu Names. 

 An overview of each main menu is found in the product-specific 

manuals. 

Toolbar 

Displays buttons that provide fast access to @ptitude Analyst’s often used procedures.  

Toolbar buttons change depending on the active window type.  To preview a toolbar 

button's function, place the mouse pointer over the toolbar button and read the pop-up 

name, or the hierarchy window's prompt / status line. 

 

Figure 2 - 3. 

Example of an @ptitude Analyst Toolbar. 
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Individual toolbar buttons are referenced in appropriate chapters later in this User 

Manual. 

Window Frame 

Used to resize the window.  To resize a window, drag and drop its window frame to the 

new dimensions. 

Working Area 

The area in which all other @ptitude Analyst windows appear. 

 

Figure 2 - 4. 

Two Windows in the Working Area. 
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SKF @ptitude Analyst Terminology 

The following terminology applies to all @ptitude Analyst applications. 

 

Figure 2 - 5. 

A Hierarchy List. 

 group (SET) 

 group (machine) 

 POINT 

Hierarchy 

A hierarchy is an organized collection of data.  @ptitude Analyst allows multiple 

Hierarchy lists per hierarchy window.  @ptitude Analyst organizes machinery 

measurement data in hierarchical format with measurement POINT hierarchy items 

branching from Group hierarchy items, which branch from the hierarchy's root node (the 

top level Hierarchy list item). 

Hierarchy List 

 
A hierarchy list is a hierarchy’s list of measurement POINTs organized by Groups.  A 

hierarchy list usually has three or four organizational levels branching from the root 

node. 

Group Hierarchy Item 

Group – Group hierarchy items help you locate specific machines and their 

measurement POINTs quickly.  Groups are SETs, Machines, or custom Group Type(s) 
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you define to meet your specific organizational needs.  A Group hierarchy item identifies 

either a specific machine (from which measurement POINTs branch) or an 

organizational SET of machines. 

 Groups (SETs, Machines, and custom Groups) and measurement 

POINTs are affected by actions on their “parent” (for example, 

delete a SET and all sub-SETs, Machines, and POINTs branching 

from the SET are also deleted). 

Organizational SET Hierarchy Item 

 Machines may be grouped into optional SETs for organizational purposes.  SETs are 

used to organize machines to help you locate specific machines and their 

measurement POINTs quickly.  Sub-SETs or Machines branch from a SET.  Sub-

SETs allow you to further organize your machines and POINTs. 

Machine Hierarchy Item 

 A machine hierarchy item is the final organizational level from which only 

measurement POINTs branch.  All POINTs must branch from a machine hierarchy 

item. 

Custom Group Hierarchy Item - Custom Group types are based on a SET-type Group 

or a Machine-type Group, and help you customize your hierarchy organization.  For 

example, you may find it useful to create the Group Type named “Pumps,” to organize 

all pump machinery and their POINTs. 

POINT Hierarchy Item 

 Defines a machinery location at which measurement data is collected and the 

measurement type (vibration - velocity, vibration - enveloped acceleration, 

temperature, etc).  Each reading is taken at a specific measurement POINT on the 

machine.  A descriptive POINT name is issued for each POINT (for example, “GAS 

TURBINE INLT 1HV” might specify a Velocity measurement taken in the Horizontal 

direction on a bearing at the driven end of a gas turbine  

 An overdue indicator icon displays next to the POINT in the hierarchy if the collection 

interval passes and no data is collected for the POINT. 

 An icon displays next to an IMx POINT in the hierarchy if a threshold out of range 

non-collection event is stored for the POINT.  

Hierarchy Status Icons 

 Disabled POINT – A disabled POINT icon displays next to the POINT in the hierarchy 

if it is not enabled for data collection. 

 Channel Disabled / Channel not set - A disable channel icon displays next to the 

POINT in the hierarchy if its assigned channel is currently disabled.   

 Alarm Status Indicators 

 In the hierarchy structure, alarm status indicators display next to hierarchy items to 

provide quick and easy feedback on a database's, machine's, or POINT's alarm 

status.   

 Danger – The item is in a danger alarm condition. 
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 Alert – The item is in an alert alarm condition. 

 Good – The item is not in an alarm condition. 

 No data - The item does not yet have stored data. 

Measurement Data Records 

 When a POINT is selected in the hierarchy (left panel), its Measurement Data Records 

display in the content list (right panel).  Measurement data records display as icons 

along with the date and time the measurement was recorded. 

 To view a measurement's type information, use the Hierarchy 

window “details” view, or use the Measurement Properties 

screen. 

ROUTE 

 

A POINT collection sequence.  ROUTEs are downloaded to a DAD (Data Acquisition 

Device) to simplify and organize POINT collection. 

Workspace 

 

An individual “work area” hierarchy window created by the user, containing a 

collection of user selected POINTs.  Workspace windows allow the user to filter and 

select a group of POINTs with which to work, without the clutter and confusion of all 

other POINTs in the hierarchy. 

Auto Link 

 
@ptitude Analyst 's Auto Link feature links any open Hierarchy, Workspace, ROUTE, 

Transient, Template, or Alarms window (source windows) to any open Alarm Details 

or Plot window (target windows).  With Auto Link enabled, selections in one of the 

source type windows automatically affect all open target type windows. 

For example, suppose you have a Hierarchy window open (source type window), select a 

POINT, and display its spectrum (target type window).  With Auto Link enabled, when 

you select a different POINT in the Hierarchy window, the plot window automatically 

updates to display the newly selected POINT's spectrum. 

Next / Previous POINT Buttons 

 

 

These buttons allow you to quickly navigate through POINTs in a hierarchy.  Using 

these buttons automatically enables Auto Link mode.  These buttons appear on the 

navigation toolbar. 

Next / Previous Measurement Buttons 

 

 

These buttons allow you to quickly navigate through measurements in a hierarchy.  

Using these buttons automatically enables Auto Link mode.  These buttons appear on 

the navigation toolbar. 
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Explorer-Type Window Operations 

@ptitude Analyst uses Windows’ Explorer-type window displays and operations for all 

hierarchical structures. 

Window Layout 

@ptitude Analyst’s Explorer-type windows are divided into two separate panels.  Using 

your mouse, right click anywhere in either panel to access a context menu based on 

your current selection. 

 

 

Figure 2 - 6. 

Explorer-Type Window Example. 

 root node 

 size bar 

 left panel 

 right panel 

Left Panel – The left panel displays the hierarchical tree structure.  The hierarchical 

structure is a list of POINTs organized by SETs and machines.  The hierarchical 

structure type is identified by its root node. 

Working in the Left Panel – The hierarchical structure expands and contracts to 

show/hide individual branching items.  

 Click the + or – icons, double-click on an item, or use the + or – keyboard keys to 

expand or contract the active hierarchical structure.   

 Click the numeric keypad's asterisk (*) key to expand all hierarchy structure items 

branching from the highlighted item. 

 Use Ctrl and the numeric keypad’s asterisk ( * ) to collapse a hierarchy branch and 

all its children. 
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 The minus sign ( - ) collapses only the current branch (not all the 

children). 

Right Panel - The right panel displays the contents of the currently selected item in the 

left panel.  There are four available display options. 

Large Icons – Displays contents in an unsorted list, with item names and large 

icons. 

Small Icons – Displays contents in rows, sorted from left to right, with item 

names and small icons. 

Simple Icon List – Displays contents in columns, sorted from top to bottom, 

with item names and small icons. 

Detailed List Icons – Displays contents in columns, sorted from top to bottom.  

Displays item names, small icons, and available details.  Click a column’s 

header to sort by the column’s category. 

 SETs and Machines display their Name and Description in the 

detail list view.  POINTs display their measurement date / time 

and summary information in the detail list view.  The type of 

summary information that displays depends upon your POINT 

settings in the POINT Properties screen.  Refer to the product-

specific manuals for more information on POINT properties. 

Manipulating List Items 

Drag and Drop Operations – You may perform drag and drop operations using the left 

or right mouse button. 

Left Click Drag and Drop – Moves the selected item to new parent, if it is a 

legal hierarchy placement.  Press ESC to cancel the current drag and drop 

operation. 

Right-Click Drag and Drop – Launches the drag and drop context menu.  

There are five available menu options: 

Move – Moves the selected item to a new parent. 

Copy – Duplicates the selected item under the destination parent.  

Copy does not duplicate measurement data. 

Re-Order – Inserts the selected item above the selected hierarchy 

drop location. 

Shortcut Link – Creates a direct link between a POINT's original 

location, and its new destination.  Use Shortcut Link to create a link 

between a POINT you place in a Workspace or ROUTE window, and 

the original POINT from the Hierarchy.  Changes made to “linked” 

POINTs affect the POINT in all other views and windows.  This option 

is only available when moving hierarchical branches from one window 

type to another. 

Cancel – Cancels the current drag and drop operation. 
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Rename – Click within an item’s name, or select an item and use the F2 key to enter 

edit mode, allowing you to change the item's name. 

 You may not rename the Hierarchy window's root node or any 

measurement name. 

Delete – Press the keyboard’s Delete key to delete the selected item.  A prompt dialog 

displays, confirming the delete operation. 

Insert – Press the keyboard’s Insert key to insert an item.  The appropriate Insert 

dialog opens based on the active window. 

 Other editing tools are available from the Edit menu. 

Using Your Mouse and Keyboard 

Mouse 

@ptitude Analyst is designed to be used with a two button mouse.  @ptitude Analyst 

observes standard Window's rules for two button mouse use. 

For example: 

 To select a menu option, point and click on the menu's name, then point and click 

on the option to select. 

 To close a menu, point and click outside the displayed menu. 

 To move an item, drag and drop the item to its new location. 

 To access more options (including a context sensitive menu), point and right-click 

on the desired item. 

Keyboard Controls 

Keyboard controls are provided in the event that mouse problems develop, and to 

quickly select often used features.  @ptitude Analyst observes standard Windows rules 

for keyboard use.  For example: 

 To move from field to field, use Tab and Shift / Tab. 

 To pull down a menu, hold down Alt and type the underlined character in the menu 

name. 

 To select a menu option, type the underlined character in the option name. 

 To close a menu, press ESC. 

 It is strongly recommended that you use a mouse for @ptitude 

Analyst procedures.  This manual is written for mouse 

procedures. 

 @ptitude Analyst’s keyboard support is detailed in Appendix C, 

SKF @ptitude Analyst Keyboard Support later in this section. 

 For more instruction on using mouse and keyboard procedures, 

reference your Microsoft Windows User's Guide. 
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Command Buttons 

 
 

 

OK and Cancel Command Buttons 

OK and Cancel command buttons appear on @ptitude Analyst screens. 

Save and Undo Command Buttons 

 
 

 

Save and Undo command buttons appear on @ptitude Analyst screens when in edit 

mode. 

On-Line Help Buttons 

@ptitude Analyst screens offer an on-line Help button that, when selected, accesses 

@ptitude Analyst’s context sensitive on-line help feature. 

Review of Standard Windows Operations 

Using the Menus 

 @ptitude Analyst menus display differently and contain different 

options depending on the installed components.  The following 

general information applies to all @ptitude Analyst applications.  

Refer to the appropriate product-specific manuals for more 

specific menu option explanations. 

Dimmed Options 

Dimmed (gray) options are not currently available (or not applicable) for the 

procedure you are attempting.  You may have to select another item (or type of 

window) before the dimmed option becomes available. 

 

Figure 2 - 7. 

Example of an ellipsis and a dimmed menu option. 

 dimmed option 

 ellipsis 
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Ellipsis 

Some @ptitude Analyst menu options display an ellipsis (...) after the option 

name.  This indicates that a dialog appears when the option is selected. 

Using Screens 

Screens are used to request information from you or to provide information to you.  In 

most screens, you select options for the procedure you are attempting. 

 

 

Figure 2 - 8. 

Example of an @ptitude Analyst Screen. 

To move from field to field: 

With the mouse pointer, click the field or area to move to. 

Keyboard  

Press Tab to move forward one field at a time; Shift / Tab to move back one 

field at a time, or 

Press Alt and the underlined letter in the name of the feature you wish to 

select. 
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 @ptitude Analyst’s keyboard support is detailed in Appendix C, 

SKF @ptitude Analyst Keyboard Support. 

Choosing Options in a Dialog 

There are many ways to select screen options: 

Text Boxes - Type information into the text box.  If the text box already contains text, 

you can use Delete or Backspace to delete the existing text, or drag the mouse 

pointer over the text and press Delete. 

List Boxes - Display a list of choices.  Click on the item(s) to select and, if necessary, 

choose the appropriate command button.  At times, more choices exist than can be 

viewed in the list box.  In this case, a scroll bar appears.  Use the scroll bar's arrows and 

scroll button to scroll the list until the desired item(s) comes into view. 

Keyboard 

Use the arrow keys to scroll to the item and press Enter to select it. 

 Drop down list boxes initially display as a rectangular box showing 

the current selection, and a down arrow in a square box to the 

right.  Click on the down arrow (or on the rectangular box) to view 

additional list box choices. 

 

Keyboard 

Alt / Down Arrow pulls down a drop down list box. 

Option Buttons - A group of option buttons display options from which only one is 

available at a time. 

Keyboard 

Use the up and down arrow keys to select the desired option. 

Check Boxes - In a group of check boxes, you may select as many options as needed. 

Keyboard 

Press Tab to move to the check box. 

Press the SPACEBAR to select the option, press the SPACEBAR again to toggle the 

selection off. 

Command Buttons - Initiate the immediate response described on the command 

button. 

Keyboard 

Press Tab to move to the desired button. 

Press Enter to initiate its action. 

 A command button followed by an ellipsis opens another dialog. 
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Menu Overview 

Following is a brief overview of each @ptitude Analyst pull-down menu.  Each menu item 

is discussed in more detail later in this manual. 

The File Menu 

The File menu is divided into five sections.  The first section provides options that allow 

you to create a New database, to Open / Close an existing database, and to Rename 

the current database. 

The second section allows you to Import data from another database, and Import 

firmware to be downloaded to a device, Export data to another database, and launch 

the Manual Archive screen. 

The third section allows you to launch the Reports screen to generate, view, create, or 

remove reports. 

The fourth section allows you to Print the contents of the active window (if the active 

window supports printing). 

The fifth section provides the Exit from @ptitude Analyst option. 

 You can also exit @ptitude Analyst by double-clicking the Main 

window's Control Menu box, or by pressing Alt / F4. 

The Edit Menu 

The Edit menu is divided into four sections.  The first section provides the following 

commands: 

Cut - Cuts a highlighted selection to the Windows “clipboard.” 

Copy - Copies a highlighted selection to the “clipboard.” 

Paste - Inserts the clipboard contents at the insertion point. 

Paste Multiple - Inserts multiple copies of the clipboard contents at the 

insertion point.  When prompted, enter the desired number of copies (1-999). 

 Paste Multiple is only available for hierarchy items that were 

copied (not cut) to the clipboard. 

Delete - Deletes highlighted items (POINTs and/or Groups) from the current 

Hierarchy, ROUTE window, or Workspace window. 

WARNING 

POINTs deleted from ROUTE or Workspace windows are deleted from the ROUTE 

or Workspace window only. 

POINTs deleted from the Hierarchy window are permanently deleted from the 

database. 

Select All - Selects everything in the Hierarchy window’s right panel list. 

The second section provides the Find command to locate POINTs and/or Groups in the 

Hierarchy window by name. 
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To Find POINTs or Groups: 

 Select the appropriate buttons to search for POINTs, Groups, or POINTs 

and Groups. 

 Searches are case sensitive.  The entered name “pump11” will 

not locate items labeled “PUMP11.” 

This function supports wildcard operations using the asterisk (*) symbol.  For 

example: 

 To search for all items that begins with the letters “pump,” enter pump*. 

 To search for all items that ends with the letters “pump,” enter *pump. 

 To search for all items that contains the letters “pump” anywhere in its 

name, enter pump or *pump*. 

When located in the window, the found item is highlighted and expanded for 

viewing.  A corresponding icon distinguishes Groups and POINTs. 

All items matching the search criteria display in the results box. 

 Select and click OK or double click any POINT or Group in the results box 

to display the selected POINT or Group in the hierarchy list. 

The third section provides the Attributes Set Baseline, and the Calculate derived 

POINTs options.   

Use the Attributes command to launch the Modify by Attribute screen.  Use 

the Modify by Attribute feature to change specific attributes (for example, 

alarm values, collection schedules, etc) for one or more machines or POINTs.  

Modify by Attribute is useful for making similar changes to a large number of 

machines and POINTs. 

A baseline is a measurement taken when the machine is in “known good” 

operating condition.  Baseline spectra are used for analysis comparison with 

future spectral measurement results.  The Set Baseline feature allows you to 

quickly reset baselines within a hierarchy after a change is made to the 

machinery.   

Use the Calculate derived POINTs command to calculate the selected derived 

POINT.  This feature allows you to quickly calculate measurement values for a 

derived POINT either upon the initial creation of a derived POINT, or after 

editing a derived POINT’s expression settings. 

The fourth section provides the Properties command to launch the Properties screen. 

corresponding to the active item. For example, if you have a POINT selected, the POINT 

Properties screen displays when you select Edit / Properties. 
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The View Menu 

The View menu is divided into five sections.  The first section provides options for 

viewing the Hierarchy, ROUTE, Workspace, Alarms, and System Information windows. 

The second section enables or disables Auto Link mode.  Enabling Auto Link causes 

other windows (plots, alarm details) to refresh contents as you navigate in the active 

view. 

The third section allows you view the Analysis and Reporting Manager and Linked 

ARM Data.  The Analysis and Reporting Manager (ARM) provides graphical displays of 

Microlog MX, GX, and AX module data (e.g., Recorder, Run up / Coast down, FRF, etc.). 

The ARM functionality in SKF @ptitude Analyst allows you to associate ARM data files 

with your hierarchy and access graphical displays of Microlog module data from within 

@ptitude Analyst.  Linked Analysis and Reporting Manager (ARM) Data allows you to 

associate ARM data files with your hierarchy and access graphical displays of Microlog 

module data from within @ptitude Analyst. 

The fourth section allows you to view the Alarm Details view, plots, and plot overlays. 

The fifth section allows you to customize @ptitude Analyst’s appearance.  The Size / 

Position command allows you to customize your display’s appearance.  Using the 

Remember and/or Forget options, you can configure @ptitude Analyst to remember or 

forget your windows’ size and position.  Display appearance settings are saved with your 

user name and password, and automatically activate when you log in.  The Icons 

command allows you to customize icon display features. 

The Insert Menu 

The Insert menu is divided into two sections.  The first section provides options that 

allow you to insert new Groups and POINTs, and to apply templates and filters. 

The second section provides the Manual Entry command to launch the Manual Entry 

screen, a Notes option to display the Notes screen of the selected Machine or POINT, 

and an Operating Time Reset to manually reset the accumulation of a machine’s total 

operating time. 

 Refer to the appropriate product-specific chapter later in this 

manual for more information on Manual Entry. 

The Transfer Menu 

The Transfer menu allows you to download and upload data to your DAD  This 

command launches the appropriate Transfer screen. 

 Refer to the appropriate product-specific chapter later in this 

manual for more information on data transfer. 
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The Customize Menu 

The Customize menu is divided into five sections.  The first section provides options to 

customize Administrator and Scheduler settings.  XML import and export operations 

are also configured here. 

The second section provides options to customize POINT Attributes and Alarm 

Attributes settings. 

The third section provides the option to customize Online Settings. 

The fourth section provides options to customize Database, Filters, and Template 

settings. 

The fifth section provides options to customize Toolbars and to set Preferences. 

 Refer to the appropriate product-specific chapter later in this 

manual for more information on Customize settings. 

The Window Menu 

The Window menu is divided into two sections.  The first section provides commands 

that control the arrangement of @ptitude Analyst windows and icons (Cascade, Tile 

Horizontal, Tile Vertical, Arrange All Windows, Arrange Icons, and a command to 

Close All open windows).   

The second section lists all open windows and allows you to select any window in the list 

to make it the active window. 

 Windows are quickly closed by double-clicking on their Control 

Menu box. 

The Help Menu 

The Help menu is divided into two sections.  The first section provides @ptitude Analyst 

Help options. 

The second section provides the About option that displays the About dialog, providing 

version, security, and plug-in information. 

 The About dialog's Security tab displays the current user name, 

access level, the base access level, and all access rights assigned 

to the current user. 
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Hierarchy Window 

Each database has its own window in which its organization of SETs, machines, and 

POINTs displays.  The Hierarchy window is the main window for the current database.  

The Hierarchy window automatically displays after a new database is created.  Use the 

Hierarchy window to set up your database hierarchy and to add or remove POINTs from 

the database. 

 

Figure 2 - 9. 

Example of a Hierarchy Window. 

 selected hierarchy item  

 selected hierarchy item's details 

 alarm status indicator 

 The Hierarchy window is the only location where you may add or 

remove POINTs. 

 Hierarchies are typically based on the physical location of the 

machinery. 

IMPORTANT 

All changes made in the Hierarchy window are permanent. 
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Hierarchy Window Keyboard Support 

Numeric keypad’s “plus” key (+) - Expands the selected item. 

Numeric keypad’s “minus” key (-) - Collapses the selected item. 

Numeric keypad’s asterisk key (*) - Expands all items beneath the selected item. 

Ctrl and numeric keypad’s asterisk key(*) - Collapses the selected hierarchy branch and 

all its children. 

Right arrow key () - Expands the selected item and navigates down to the child level 

Left arrow key () - Collapses the selected item and navigates up to the parent level. 

Up () and Down () arrow keys - Navigate up and down in the list. 

ROUTE Window 

Use the ROUTE window to organize POINTs in the order you wish to collect data.   

 Edits to Group items (deleting, re-ordering, or re-positioning) in 

the ROUTE window do not apply outside the ROUTE window. 

IMPORTANT - In a ROUTE window, changes to a POINT’s placement in the list and 

POINT deletions do not affect the Hierarchy window (database).  However, changes to 

individual POINT setup settings (POINT Properties) do apply to the database and reflect 

in the Hierarchy window. In @ptitude Analyst, anytime you enter a POINT Properties 

screen, changes made to the POINT’s setup properties affect the database and reflect in 

the Hierarchy window. 

Changes to Group Properties do not affect the database / Hierarchy window. 

 

 

Figure 2 - 10. 

Example of a ROUTE Window. 
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 Refer to the appropriate product-specific manuals for more 

information on creating and using ROUTEs. 

Workspace Window 

Use Workspace windows to organize specific Groups into one location for easy 

comparison and analysis.   

 Deleting, re-ordering, or re-positioning Groups or POINTs apply 

only to the Workspace and do not affect the Hierarchy. 

 Edits to Group Properties in the Workspace window do not apply 

to the Hierarchy 

IMPORTANT - In a Workspace window, changes to a POINT’s placement in the list 

and POINT deletions do not affect the Hierarchy window (database).  However, 

changes to individual POINT Properties do apply to the database.  Anytime you 

enter a POINT Properties screen, changes made to the POINT’s setup properties 

affect the database and reflect in the Hierarchy window. 

 

Changes to Group Properties do not affect the database / Hierarchy window. 

Workspaces may be created manually or automatically using filtering. 

 

Figure 2 - 11. 

Example of a Workspace Window. 

To open an existing Workspace: 

 Select the View menu’s Workspace option.  The Workspace screen displays. 
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Figure 2 - 12. 

The Workspace Screen. 

 Select the existing Workspace and click the Open command button.  The selected 

Workspace window opens. 

To manually add a new Workspace: 

 Click the Workspace screen’s Add button.  The Workspace Properties screen 

displays.  Enter desired workspace properties and click the OK button.   

Once all workspace properties are specified, the newly created workspace appears in the 

Workspace screen.  You can add hierarchy items to the new workspace using the Insert 

menu options, copy and paste, or drag and drop operations. 
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Workspace Properties / General 

 

Figure 2 - 13. 

The Workspace Properties Screen’s General Tab. 

Workspace Properties / General tab fields include: 

Name – Enter a new Workspace name. 

Description – Enter a new description. 

 Filter information and options are only available in the Filter Info 

area if the Workspace was created using filtering.   

Last applied – Displays the date the current filter was last applied. 

Three filtered Workspace save options are available.  Select from: 

Reapply filter when workspace opens 

Ask to reapply when workspace opens 

Only reapply via menu selection 

 Click OK to save changes. 

 The number of POINTs included in the selected workspace display at the bottom of 

the screen. 
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Workspace Properties / Filter Criteria 

When you apply a filter to a Hierarchy, the filtered results display in a workspace.  When 

you open a “filtered” workspace, you can view the filter criteria that created it in the 

Workspace Properties / Filter Criteria tab.  You can also modify the filter criteria, and 

reapply the filter to modify the workspace. 

 

Figure 2 - 14. 

The Workspace Properties Dialog’s Filter Criteria Tab. 

The current filter's name displays in the Filter: field. 

 Click the Keep hierarchy checkbox to keep the original hierarchical format intact 

and arrange filtered POINTs beneath the parent item name.  When disabled, 

filtered POINTs appear beneath the filtered machine without the machine’s parent 

items. 

 In the screen's Filter from portion, select Root node – My Hierarchies to search 

all open hierarchies for POINTs matching the filter criteria.  Select Selected node to 

search only from the selected node and below. 

 In the screen's Filter on attributes area, specify which attributes on which to filter.  

Attributes specific to machine, measurement, POINT, data type, and/or attribute 

type are grouped together.  Select an attribute group to modify. 

 Individual attribute settings for the selected attribute group display in the screen's 

Settings area.  Use the edit fields to view and/or edit attributes as necessary. 

 When one or more attributes within an attribute group is included 

in the current filter, a checkmark displays next to the attribute 

group folder. 
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 Use the All and Clear buttons to quickly include all or none of the displayed 

attributes for the selected attribute group in your current filter (rather than 

selecting / de-selecting one by one). 

You can either filter for POINTs that match every attribute setting, or filter for POINTs 

that match at least one attribute setting. 

 In the Include field, select Any Selected or All Selected.  Select Any Selected to 

filter for POINTs matching any individual attribute of the total included in the filter.  

Select All Selected to filter for POINTs matching all attributes included in the filter. 

The number of attributes selected and the total number of available attributes displays 

in the screen's lower left corner. 

 Click Share As to assign the current filter a unique name and make it available as a 

shared filter, to be used repeatedly.  The Enter Filter Name dialog displays.  Enter 

a unique name and click OK. 

 Click the Apply Filter dialog's OK button to create a new workspace based on the 

defined criteria of the current filter.  A progress bar displays indicating the filter’s 

status. 

 Click Cancel to close the dialog without applying the filter and without saving your 

filter entries. 

To remove an unnecessary Workspace: 

 In the Workspace screen, select the Workspace name. 

 Click the Remove button.  Confirm action when prompted.  The selected Workspace 

is removed. 

To auto-filter a Workspace: 

 In the Workspace screen, select a Workspace name(s). 

 Click the Apply Filter button.  Every filtered workspace will reapply the filter. 

Transient Window 

 
The Transient Data feature is used to collect and analyze transient vibration signals 

from non steady state machinery.  The Transient Window is documented in detail in 

the SKF @ptitude Analyst for SKF Multilog On-Line Systems manual’s Transient Data 

Analysis chapter. 
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Template Window 

 

Templates allow you to define custom organizational structures for repeated use 

when building or defining databases.  The same template may be used across many 

different databases.  Using templates saves time, contributes to consistent 

organization, and allows you to make bulk entries. 

 

Figure 2 - 15. 

Example of a Template Window. 

IMPORTANT 

Templates do not contain measurement data. 

To open an existing template: 

 Select the Customize menu’s Template command.  The Template window 

displays. 
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Figure 2 - 16. 

The Template Window. 

 Select an existing Template and click the Open command button.  The selected 

Template window opens. 

 The Template window's entries can be sorted by clicking the 

column headers.   

To add a new Template: 

 Click the Template window’s Add button.  The Template Properties screen 

displays. 

Template Properties / General fields include: 

Name – Enter a new Template name. 

Description – Enter a new Template description. 

Type – Specify the template’s Type.  Type in a new template type, select a 

previously created template, or  select <Custom> from the drop down menu.   

To remove an unnecessary Template: 

 In the Template window, select the Template name. 

 Click the Remove button.  Confirm action when prompted.  The selected Template 

is removed. 

 Refer to the appropriate product-specific chapter later in this 

manual for more information on creating and applying templates. 
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Alarms Window 

Use the Alarms window to display all POINTs currently in alarm.  The Alarms window 

makes it easy to locate alert and danger alarms in a single, organized view. 

IMPORTANT - As is the case anytime you enter a POINT Properties screen, any 

changes made to a POINT’s setup properties from the Alarms window affect the 

database and reflect in the Hierarchy window. 

To view the Alarms window: 

 Select the View menu’s Alarms option.  The Alarms window displays. 

 

Figure 2 - 17. 

The Alarms Window. 

 Select a specific Hierarchy, ROUTE, or Workspace from the drop down list in the 

Alarms for area. 

All POINTs in alarm (for the selected view) display, including the POINT name and 

description, the Machine name, description, and priority, the hierarchy in which the 

POINT is found, the alarm level, the measurement’s date / time that caused the alarm, 

whether or not the alarm has been acknowledged, and the operator who collected data 

for the POINT in alarm.  

A right-click menu on an alarm provides the following options: 

Plot – Provides a menu of plot options for the POINT.  

Alarm Details – Opens the Alarm Details screen where you can quickly identify and 

analyze the type of alarms causing a selected POINT to display an alarm icon 

Acknowledge Alarm – Flags alarms with an Acknowledged status, allowing users to 

quickly separate new alarms from old ones. 
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Acknowledge All Alarms – Flags all alarms in the Alarms window with an 

Acknowledged status. 

Go to Hierarchy – Jump to the POINT in the hierarchy window. 

Properties – View and edit POINT Properties. 

Once you have viewed an alarm, it is recommended you acknowledge it.  Acknowledging 

an alarm indicates that someone has already reviewed the issue and it is being handled.  

Although the alarm continues to appear in the Alarms window, the acknowledgement 

provides a visual indication that this is not a new alarm, and that it has already been 

reviewed. 

 The Acknowledge Alarms access level must be enabled. 

To Acknowledge an Alarm:  

 Right click on the alarm in the Alarms window and select Acknowledge Alarm or 

Acknowledge all Alarms from the popup menu.  The Acknowledge Alarm Note 

dialog displays. 

 Enter any desired notes concerning the alarm and click OK to save the 

acknowledgement.  (These notes are accessible from the Notes tab in POINT 

Properties for the related POINT.) 

 Once an alarm has been acknowledged, it cannot be undone 

manually.  The only way an alarm can revert to unacknowledged 

is if the alarm level changes, based on your Global Preferences 

settings. 
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Plot Window 

The Plot window displays collected measurements in various graphic plot formats for 

machinery analysis purposes. 

 

Figure 2 - 18. 

Example of a Plot Window. 

 Refer to the appropriate product-specific chapter later in this 

manual for more information on plot types, plot settings, and plot 

overlays. 

Alarm Details View 

Use the Alarm Details view to quickly identify and analyze the type of alarms causing a 

selected POINT to display an alarm icon. 

To view a selected POINT’s Alarm Details: 

 Select a POINT in the hierarchy. 

 Select the View menu’s Alarm Details option.  The Alarm Details View window 

displays. 
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Figure 2 - 19. 

The Alarm Details View. 

The Alarm Details View displays a summary of all alarms that have been processed for 

the selected POINT. 

Information displays in the following fields in the window’s top area: 

 POINT – POINT name. 

 Machine – Selected POINT’s location. 

 Path – Selected POINT’s hierarchy path. 

 Description – POINT description. 

 Alarm Level – Selected POINT’s highest alarm level. 

 Date / Time – Date and time of last measurement. 

Individual alarms for the selected POINT display in the window’s bottom area, indicating 

their Level, Name, and Details (if provided).  Any alarm messages associated with the 

POINT's overall alarm settings also display. 

 The Based On column applies to HAL alarms only and indicates 

the measurement on which the displayed alarm status was based. 

If the latest HAL calculation failed for any frequency, the Based 

On column contains a date/time stamp for that frequency’s alarm 

detail indicating the date/time of the frequency’s last successful 

HAL calculation. 

Tip - Select the View menu’s Auto Link option or click the Auto Link toolbar button to 

enable the Auto Link feature.  Alarm Details information will update automatically as 

different POINTs are selected. 
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System Information View 

@ptitude Analyst’s System Information display provides detailed Event Log and data 

information. 

 

Select the View menu’s System Information option or click the System Information 

toolbar button.  The System Information display appears. 

 

 

Figure 2 - 20. 

The System Information View. 

When an Event Log or other data item is selected, additional details display in the lower 

area. 

The System Information’s Alarm Details and Measurement buttons provide 

additional information about the selected Event Log or other data item, if the selected 

item has POINT information. 

Alarm Details – Describe the alarmed POINT.  The detail information may be sorted by 

Level, Name, or Details by clicking the appropriate header. 

Measurements - Display the measurement history for the selected POINT.  The 

measurement history may be sorted by Date / Time or Summary. 

Alarm Details 

The System Information window's Alarm Details tab describes the selected POINT's 

alarm types and current conditions.  The detail information may be sorted by Level, 

Name, or Details by clicking the appropriate header. 

Measurement Details 

The System Information window's Alarm Details tab describes the selected POINT's 

measurement Date / Time and Summary.  The detail information may be sorted by 

clicking the appropriate header. 
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Event Log 

The Event Log stores and displays a list of alarms and events that have occurred on the 

system.  The most recently collected event data displays at the top of the Event Log list. 

To view the Event Log: 

 In the display’s left panel, click the Event Log item.  The Event Log information 

displays in the right panel. 

 

Figure 2 - 21. 

The Event Log. 

Each event is identified with its: 

Date / Time 

Event 

Type 

POINT ID 

Host 

DAD Type 

Device 

User 

Hierarchy 

Acknowledged By 

Acknowledged Date 
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The Event Log displays specific messages which classify each event type according to the 

different events which occur in the system.  Possible event types are as follows: 

Access 

Data Collection 

Communication 

Online Alarm 

Configuration 

Monitor 

Protection Alarm 

Protection Event 

Event Log Column Selection 

With an event log item selected, right click to display the context menu.  Select the 

Columns option.  The Select Columns screen displays. 

 

Figure 2 - 22. 

The Select Columns Screen. 

Use the Select Columns screen to specify which columns appear in the event log, to 

specify column order, and select column sort criteria. 

All available columns appear in the Available columns area.  All included columns 

appear in the Included columns area. 

To add / remove columns: 

 Click the column type to select it. 

 Use the Include and Exclude buttons to add or remove the column from the 

Included columns area. 
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To specify column order: 

 Click the column type in the Included columns area to select it. 

 Use the Up and Down buttons to place the column into the desired position. 

To specify sort criteria: 

 Select a column type from the Sort on drop down list box. 

 Click the desired sort method button, Ascending or Descending. 

 Click OK to save changes. 

 Click Cancel to undo settings. 

Event Log Filtering 

@ptitude Analyst’s Event Log filter allows you to control the content of the Event Log by 

filtering out events you do not wish to be included in the log.  The Event Log filter 

supports Boolean commands to create filter settings.   

To create a new Event Log Filter: 

 Right-click anywhere in the Event Log’s right panel to display the context menu. 

Select Filter / Add.  The Edit Event Log Filter dialog displays. 

To apply an existing Event Log Filter: 

 Right-click anywhere in the Event Log’s right panel to display the context menu.  

Select the Filter option to display the Filter submenu. 

 All previously created Event Log filters display in the Filter submenu, including the 

<No Filter>, All Alarms, IMx-M RFO, IMx-M SFO Protection Alarms, and System 

Events options.   

 Highlight the filter name in the submenu to select it.  The filter is immediately 

applied and only events meeting the selected filter’s settings display. 

When a filter is currently active, a checkmark displays next to its name in the Filter 

submenu. 

To edit an existing Event Log Filter: 

When a filter is active, you may edit its settings. 

 Right-click anywhere in the Event Log’s right panel to display the context menu.  

Select the Filter option to display the Filter submenu. 

 Verify the filter you wish to edit is the active filter.  The active filter is identified by a 

checkmark next to its name in the Filter submenu. 

 Select the Edit option.  The Edit Event Log Filter dialog displays. 
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To remove an existing Event Log Filter: 

When a filter is active, you may permanently remove it. 

 Right-click anywhere in the Event Log’s right panel to display the context menu.  

Select the Filter option to display the Filter submenu. 

 Verify the filter you wish to remove is the active filter.  The active filter is identified 

by a checkmark next to its name in the Filter submenu. 

 Select the Remove option.  The current Event Log filter is removed. 

Edit Event Log filter dialog 

 

Figure 2 - 23. 

The Edit Event Log Filter Dialog. 

@ptitude Analyst’s Event Log filter allows you to control the content of the Event Log by 

filtering out events you do not wish to be included in the log.  The Event Log filter 

supports Boolean commands to create filter settings. 

The “OR” command allows any of the specified filter terms to appear in the results.  It 

can also be described as a “match any” filter.  For example, you would use the “OR” 

command if you wanted your Event Log to contain events when the DAD Type is a 

Microlog or the Event Type is Data Collection.  In this case, any event with the Microlog 

as the DAD Type (not limited to data collection) as well as any data collection event type 

(not limited to the  Microlog DAD type)  would be included in the Event Log. 

The “AND” command requires all filter terms be present to appear in the results.  It can 

also be described as a “match all” filter.  For example, you would use the “AND” 

command if you wanted your Event Log to contain events when the DAD Type is a 
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Microlog and the Event Type is Data Collection.  In this case, only events with the 

Microlog DAD Type related to Data Collection would be included in the Event Log.   

You may also create complex filters using a combination of “AND” and “OR” commands.  

For example, to display everything related to User “John” that is either “Microlog” 

related or “Access” related, you must create an event log filter that includes everything 

related to John AND everything related to the Microlog OR Access.   

The Edit Event Log filter dialog allows you to create new Event Log filters and edit 

existing Event Log filters.   

To add a new Event Log Filter: 

 Select the Filters submenu’s Add option.  The Edit Event Log Filter dialog displays. 

 Enter the new filter’s name in the dialog’s Filter name field. 

 The new filter defaults to an Or command.  If necessary, highlight the Or command 

and click the Change button to toggle your command between Or and And.  Use 

the And command to create a “match all” type filter.  Use the Or command to 

create a “match any” type filter. 

 If necessary, click the And button to add an And condition below the top branch.  If 

necessary, highlight the And condition and click Change to toggle to an Or 

condition. 

 Highlight the desired And or Or command and click Add Rule to add a filter 

condition.  A pop-up menu displays with filter criteria categories.  For example, you 

may filter on a specific date/time range, or a type of DAD. 

 Highlight the desired filter criteria category on the menu.  A sub-menu displays 

additional criteria selection options.  For example, if you select the DAD Type item, 

you can then specify whether the Event Log item must be the selected DAD Type, 

must not be the selected DAD Type, or must be one of a selection of DAD Types 

you have specified.  In this case, when the DAD Type item is selected, you are 

prompted to select either Is Not or Is.  Select Is Not to determine what is excluded 

from your filter and display a listing of DAD Types to select from.  Select Is to 

determine what should be included in your filter and display a listing of DAD Types 

to select from.  With either selection, a list of all available DAD types and the 

Selection of option displays.  Select the appropriate DAD Type to include / exclude 

it from your filter.  Select Selection of to display the Select One or More dialog to 

select multiple items.   

 Click an item to select it.  All selected items display in the dialog’s Display Item 

When panel, branching from the selected command type.  

 If you add an item in error, highlight it in the Display items when list and click 

Remove. 

 Click OK to save your selections, click Cancel to close the dialog without saving your 

selections. 
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Event Log Column Filter Criteria Options 

Acknowledge By 

Name Does Not Match – Displays the Enter Text dialog, allowing you to enter text that 

the filter will search for in the usernames of those who have acknowledged events.  

Events with usernames containing your entered text are excluded from the Event Log. 

Name Matches – (opposite of Name Does Not Match) Displays the Enter Text dialog, 

allowing you to enter text that the filter will search for in the usernames of those who 

have acknowledged events.  Events with usernames containing your entered text are 

included in the Event Log. 

 Refer to the Enter Text  dialog description later in this section for 

more information. 

Is – Select individual usernames from the list, or select multiple usernames from the 

Select One or More dialog.  Only events that have been acknowledged by the selected 

usernames will appear in the Event Log.  Click Any to show only events that have been 

acknowledged.  Any unacknowledged events will not display in the event log.   

Is Not – (opposite of Is) Select individual usernames from the list, or select multiple 

usernames from the Select One or More dialog.  Events that have been acknowledged 

by the selected usernames will not appear in the Event Log.  Click Any to show only 

events that have not been acknowledged.  Any events that have already been 

acknowledged will not display in the event log. 

Acknowledge Date 

Within Range Of – Displays the Select Date Range dialog, allowing you to select fixed 

(date/time) or relative (time period) data range parameters to establish a date range.  

All events that have been acknowledged within this date range will display in the event 

log. 

Before – Displays the Select Date Range dialog, allowing you to select fixed (date/time) 

or relative (time period) data range parameters to establish an end date and time.  Only 

events that have been acknowledged on or before the selected date / time will display in 

the event log. 

Since - Displays the Select Date Range dialog, allowing you to select fixed (date/time) 

or relative (time period) data range parameters to establish a start date and time.  Only 

events that have been acknowledged on or after the selected date / time will display in 

the event log. 

 Refer to the Select Date Range dialog description later in this 

section for more information. 

DAD Type 

Is – Select individual DAD Types from the list or a selection of DAD Types from the 

Select One or More dialog. 

Is Not – Select individual DAD Types from the list or a selection of DAD Types from the 

Select One or More dialog. 

 Refer to the Select One or More dialog description later in this 

section for more information. 
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Date / Time 

Within Range Of – Displays the Select Date Range dialog, allowing fixed or relative 

data range parameters to establish a date range. 

Before - – Displays the Select Date Range dialog, allowing fixed or relative data range 

parameters to establish an end date and time. 

Since - Displays the Select Date Range dialog, allowing fixed or relative data range 

parameters to establish a start date and time. 

 Refer to the Select Date Range dialog description later in this 

section for more information. 

Device 

Name Does Not Match – Displays the Enter Text dialog, allowing you to enter text.  

Devices with names containing your entered text are excluded from devices in the Event 

Log. 

Name Matches - Displays the Enter Text dialog, allowing you to enter text.  Devices 

with names containing your entered text are included with devices in the Event Log. 

 Refer to the Enter Text  dialog description later in this section for 

more information. 

Is – Select individual Device Types from the list or a selection of Device Types from the 

Select One or More dialog. 

Is Not – Select individual Device Types from the list or a selection of Device Types from 

the Select One or More dialog. 

Event 

String Does Not Match - Displays the Enter Text dialog, allowing you to enter text.  

Events containing your entered text are excluded from events in the Event Log. 

String Matches - Displays the Enter Text dialog, allowing you to enter text.  Events 

containing your entered text are included with events in the Event Log. 

 Refer to the Enter Text  dialog description later in this section for 

more information. 

Host 

Name Does Not Match – Displays the Enter Text dialog, allowing you to enter text.  

Hosts with names containing your entered text are excluded from hosts in the Event 

Log. 

Name Matches - Displays the Enter Text dialog, allowing you to enter text.  Hosts with 

names containing your entered text are included with hosts in the Event Log. 

 Refer to the Enter Text  dialog description later in this section for 

more information. 

Is – Select individual host names from the list or a selection of host names from the 

Select One or More dialog. 

Is Not – Select individual host names from the list or a selection of host names from the 

Select One or More dialog. 
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 Refer to the Select One or More  dialog description later in this 

section for more information. 

Machine 

Name Does Not Match – Displays the Enter Text dialog, allowing you to enter text.  

Machines with names containing your entered text are excluded from machines in the 

Event Log. 

Name Matches - Displays the Enter Text dialog, allowing you to enter text.  Machines 

with names containing your entered text are included with machines in the Event Log. 

 Refer to the Enter Text  dialog description later in this section for 

more information. 

Is – Select individual machine names from the list or a selection of machine names.  If 

you select Selection Of… the Select Item dialog displays, allowing you to select 

multiple machines from the hierarchy list. 

 Refer to the Select Item  dialog description later in this section 

for more information 

Is Not – Select individual machine names from the list or a selection of machine names 

from the Select One or More dialog. 

 Refer to the Select One or More  dialog description later in this 

section for more information 

POINT 

Name Does Not Match – Displays the Enter Text dialog, allowing you to enter text.  

POINTs with names containing your entered text are excluded from POINTs in the 

Event Log. 

Name Matches - Displays the Enter Text dialog, allowing you to enter text.  POINTs 

with names containing your entered text are included with POINTs in the Event Log. 

 Refer to the Enter Text dialog description later in this section for 

more information  

Is – Select individual POINTs from the list or a selection of POINT names.  If you select 

Selection Of… the Select Item dialog displays, allowing you to select multiple POINTs 

from the hierarchy list. 

 Refer to the Enter Text dialog description later in this section for 

more information. 

Is Not – Select individual POINTs from the list or a selection of POINT names from the 

Select One or More dialog. 

 Refer to the Select One or More dialog description later in this 

section for more information. 
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Type 

Is – Select individual event Types from the list or a selection of event Types from the 

Select One or More dialog. 

Is Not – Select individual event Types from the list or a selection of event Types from 

the Select One or More dialog. 

 Refer to the Select One or More dialog description later in this 

section for more information. 

User 

Name Does Not Match – Displays the Enter Text dialog, allowing you to enter text.  

Users with names containing your entered text are excluded from Users in the Event 

Log. 

Name Matches - Displays the Enter Text dialog, allowing you to enter text.  Users with 

names containing your entered text are included with Users in the Event Log. 

 Refer to the Enter Text dialog description later in this section for 

more information. 

Is – Select individual User names from the list or a selection of User names from the 

Select One or More dialog. 

Is Not – Select individual User names from the list or a selection of User names from 

the Select One or More dialog. 

 Refer to the Select One or More dialog description later in this 

section for more information. 

Select Date Range dialog 

The Select Date Range dialog allows you to enter a date range to use in your Event 

Log filter. 

Date Type – Select Fixed or Relative 

Fixed – Select to enter a start (From) date and time and an end (To) date and time, 

establishing a fixed date range.  For example, enter a fixed date range of: 

From 1/1/2003 at 8:00:00 AM  

To 1/31/2003 at 8:00:00 PM. 

Relative – Select to enter a start (From) time and an end (To) time, establishing a 

relative date range.  For example, enter a relative date range of: 

From 24 Hours Ago  

To 2 Hours Ago 

 Click OK to save your date range, click Cancel to close the dialog without saving 

your date range settings. 
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Enter Text Dialog 

The Enter Text dialog allows you to enter text to use in your Event Log filter. 

Text:  Type appropriate text in the text field. 

The Enter Text dialog supports standard wildcard operations.  The question mark 

character (?) matches any single character and the asterisk character (*) matches zero 

or more characters.  For example, if you have POINTs named “New POINT,” “New 

POINT.1,” and “New POINT.2”, different uses of the wildcard characters in your event 

log filter will affect which items are included in the filter results.  If you enter “New 

POINT” in the dialog’s text field, only the POINT named “New POINT” will be included in 

your filter results.  If you enter “New POINT.?” In the dialog’s text field, “New POINT.1” 

and “New POINT.2” will be included in your filter results because the question mark 

character “matches” any single character in the item’s name; in this case, the numeric 

suffix at the end of the POINT name.  If you enter “New POINT*” in the dialog’s text 

field, all three POINT names will appear in your filter results because the asterisk 

character “matches” any or all characters in the item’s name; in this case, the POINTs 

with the numeric suffix and the POINT without the numeric suffix. 

 Click OK to save your entered text, click Cancel to close the dialog without saving 

your entered text. 

Select One or More Dialog 

The Select One Or More dialog allows you to select a single item, or multiple items to 

use in your Event Log filter. 

Available items display in the dialog’s window.  Click item(s) to select. 

 Click OK to save your selections, click Cancel to close the dialog without saving your 

selections. 

Select Item Dialog 

The Select Item dialog allows you to select a multiple POINTs or machines from a 

hierarchy list to use in your Event Log Filter. 

Contact Information 

Use the Contact Information screen to create and edit contacts and store contact 

information, including e-mail addresses and routing information for sending SMS text 

messages.   

The Contact tab allows you to create, edit, and remove individual contacts.  The Group 

tab allows you to create groups of individual contacts.  Each tab is discussed in detail in 

the sections below. 

Once your contacts and contact groups are set up, you can send emails and text 

messages to individual contacts or groups from @ptitude Analyst’s Reports and 

Scheduler screens.  
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Contact Tab 

The Contact tab allows you to create new contacts, edit existing contacts, and remove 

existing contacts. 

To create an individual contact: 

 Select the Customize menu’s Contact Information option.  The Contact 

Information screen displays.  

 

Figure 2 - 24. 

The Contact Information Screen’s Contact Tab. 

The Individual contacts list displays all current contacts’ first and last name, email 

address, the SMS text phone number, and any groups to which they belong. 

 If Send to email or Send to cell phone (SMS text) are not 

enabled, the list displays ‘Not enabled’. 

 Click the Add button and enter the necessary information into the Details area.   
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Fields include: 

First name / Last name – Enter the contact’s first and last name.  

 Only the First name field is required. 

Send to email – Enable the check box and enter the contact’s email address.  

 Click the Test Email button to send a test email to the specified email address.  A 

message displays if the email address is valid and the email is sent successfully.  An 

error message displays if the email address does not appear to be valid. 

 Before you can send an email from @ptitude Analyst, you must 

enter your SMTP Settings in the SKF @ptitude Analyst 

Configuration Tool.  Reference your SKF @ptitude Analyst 

Installation Manual’s Database Configuration / SMTP Settings 

section for details. 

Send to cell phone – Enable the check box and enter the contact’s cell phone number.  

The phone number must only use numeric characters.  Do not use spaces, dashes, 

parenthesis, etc.   

Service Provider – Select the contact’s cell phone service provider from the drop down 

list or click the New button to add a new service provider or edit the service provider’s 

information.  If you click the New button, the Cell Phone Service Provider dialog 

displays. 

 

Figure 2 - 25. 

The Cell Phone Service Provider Dialog. 
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 Click the Add button to create a new service provider. 

 Enter the Provider name, Gateway prefix, and Gateway address.   

 If you do not know the Gateway prefix and/or Gateway address, 

you may perform an internet search for “SMS Gateway” and 

select one of the free lists that displays in your search results; or 

contact the service provider to obtain the Gateway prefix and 

Gateway address.   

 Click OK to return to the Contact tab. 

 On the Contact tab, click the Test SMS button to send a test text message to the 

cell phone number specified in the Send to cell phone text box.  A message 

displays if the cell number and service provider information is valid and the text 

message is sent successfully.  An error message displays if the cell phone number 

or service provider information does not appear to be valid. 

Groups – If you wish to add the contact to a group, select a group from the drop down 

list.   

 You must create and edit groups on the Group tab.  You may also 

add / remove contacts to groups on the Group tab. 

 Click the Save button to save the contact information. 

To edit an existing contact:  

 On the Contact tab, select the contact you wish to edit from the Individual 

contacts list. 

 Edit the fields in the Details area as necessary.   

 Click Save to save your changes, or click Undo if you do not wish to save your 

changes. 

To remove an existing contact:  

 On the Contact tab, select the contact you wish to edit from the Individual 

contacts list. 

 Click the Remove button.  A message displays asking if you want to remove the 

selected contact.   

 Click Yes to continue or No to cancel. 
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Group tab 

The Group tab allows you to create new groups, edit and remove existing groups, and 

add or remove contacts to groups.  

 

Figure 2 - 26. 

The Contact Information Screen’s Group Tab. 

Fields include: 

Interest groups – Displays a list of the existing groups. 

Details area – Edit the group name and group contacts in the fields below. 

Available contacts – Displays a list of contacts not yet added to the group. 

Included contacts – Displays a list of contacts already added to the group. 

To create a new group: 

 Click the Add button.  A new group is added to the Interest groups list.   

 Edit the group name in the Group name text box. 
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 Click Save.  The new group name displays in the Interest groups list. 

To add contacts to a group: 

 Select a group name from the Interest groups list. 

 In the Available contacts list, highlight the contact name you wish to add to the 

group.   

 Click the Include button.  The name moves from the Available contacts list to the 

Included contacts list. 

 When you have added all of the contacts to the group, click Save to save your 

changes.  If you do not wish to save your changes, click Undo. 

To remove contacts from a group: 

 Select a group name from the Interest groups list. 

 In the Included contacts list, highlight the contact name you wish to remove from 

the group.   

 Click the Exclude button.  The name moves from the Included contacts list to the 

Available contacts list. 

 When you have removed all of the contacts from the group, click Save to save your 

changes.  If you do not wish to save your changes, click Undo. 

To remove a group: 

 Select a group name from the Interest groups list. 

 Click the Remove button.  A message displays asking if you want to remove the 

group.   

 Click Yes to remove the group, or No to cancel. 

 Click OK to exit and save all changes made on the Contact Information screen.   

 Click Cancel to exit the Contact Information screen without saving your changes. 

Customizing Your SKF @ptitude Analyst Software 

 If selected during installation, @ptitude Analyst’s Demo database 

is installed.  This database allows new users of @ptitude Analyst 

to familiarize themselves with the software using the supplied 

“sample” @ptitude Analyst data.   

Administrative Setup 

Each user must have a user name to log in.  Each user name has a specified access 

level.  You can use the default access levels, or create your own.  Use the Customize 

menu’s Administrator option to add, remove, and customize user names, to create 

custom access levels, to set Hierarchy access, and to reset passwords. 

 You must log in (initially) as “ADMIN” to have administrative 

authority.  You may then add additional user names with specified 
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access levels using the Administrator screen’s Users and Levels 

tabs. 

 If you are logged in as “ADMIN,” you cannot change your own 

access rights or remove your own account. 

 Passwords are case-sensitive. 

To set up user names and passwords: 

 Select the Customize menu’s Administrator option.  The Administrator screen 

displays. 

 

Figure 2 - 27. 

The Administrator Screen’s Users Tab – Set Access by User Mode. 

The Users tab has two modes: 

Set access by user - Select this mode to manage users organized by user 

name. 

Set access by hierarchy - Select this mode to manage users organized by 

Hierarchies. 
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Set Access by User Mode 

In Set access by User mode, all available user names and their access levels display in 

the Users area.  Available Hierarchies and their access controls display below each user 

name.  In this mode, you can add or remove users, set Hierarchy access, and reset 

passwords. 

To set up user names : 

 Click the Users tab’s Add button and enter the new user name in the User name 

text box. 

 Select the desired Access Level from the Access Level drop down list box. 

Five default access levels and all custom levels created appear in the drop down menu 

and are available for selection.  Custom access levels are discussed later in this section. 

Default access levels are: 

View Data HMI Operator – Permitted to view hierarchies and data as well as HMI 

mimic screens. 

Operator – Most restricted access.  Permitted to view and collect data only. 

Technician – Has all rights of Operator with additional rights to manage measurements 

and define special data views. 

Analyst – Has access to complete system with the exception of administrative rights. 

Administrator – Full access to the system, authority to add / remove users and access 

rights. 

 Click the Save button to accept the name and access level for the new user. The 

new user name and access level appears alphabetically in the Users area.  The 

available hierarchies display below each user.   

 Select the checkboxes next to the Hierarchy below the user's name to give a specific 

user access to a specific Hierarchy. 

 Users with “Administrator” Access Levels have access to all 

Hierarchies.  No access controls are available for these users.   

 To give a single user access to all hierarchies, select the checkbox 

next to that user’s name. 

To remove a User Name and Access Level: 

 Click the user name in the Users area to select it. 

 Click the Remove button.   

 A confirmation dialog appears.  Click Yes to confirm user name removal.  The user 

name is deleted. 

 Modifications to User names, Access Levels, Hierarchy access, 

and passwords do not take effect until that user’s next log in.  For 

example, if you change a user’s access level, the new access rights 

will not be in effect until the user logs out, and then logs in again. 

 When a new user is created, that user must enter and confirm a 

new password the next time they log in. 
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To reset a User name password: 

 Select the user name in the Users area. 

 Click the Reset Password button.   

 A confirmation dialog appears.  Click Yes to confirm reset.  The password is reset.  

That user must enter and confirm a new password the next time they log in. 

Set Access by Hierarchy Mode 

 

Figure 2 - 28. 

The Administrator Screen’s Users Tab – Set Access by Hierarchy Mode. 

In Set access by Hierarchy mode, available hierarchies display in the window.  All users 

and their access levels display below each Hierarchy.  In this mode, you can customize 

the users’ Hierarchy access. 

 Users with “Administrator” Access Levels have access to all 

Hierarchies.  No access controls are available for these users.   

 In Set access by Hierarchy mode, the User properties area and 

the Add, Remove, and Reset Password buttons are unavailable. 
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To set Hierarchy access: 

 Select the checkboxes next to the user's name below the Hierarchy to give a specific 

user access to a specific Hierarchy.   

 To give all users access to a single hierarchy, select the checkbox 

next to that Hierarchy’s name.  

Access Levels 

Administrators may add customized access levels, based on the defaults of the existing 

access levels, and assign to individual or multiple users.   

Use the Levels tab to customize access for particular users to meet your application’s 

requirements.  You can expand user access by allowing certain access rights to levels 

not given default access, or you can restrict user access by preventing access from levels 

with default access. 

 

Figure 2 - 29. 

The Administrator Screen’s Levels Tab. 

To create a custom Access Level: 

 Click the Add button to create a new access level. 

 Initially, a default name and setting are assigned to the new 

access level.  

 Enter a name for your custom Access Level in the Name text box. 
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 Select a Default base level from the drop down list.  Options include View Data 

HMI Operator, Operator, Technician, Analyst, and Administrator.  Basing your 

custom access level on an existing access level allows you to edit only the access 

rights you wish to expand or restrict in your new level. 

 The default access rights for the selected default base level appear in the Access 

settings window. 

 Edit each access right as desired using the Allow and Prevent buttons.  The 

checkmark symbol indicates “allowed” and the lined-through circle symbol indicates 

“prevented.” 

 Click the Default button to return the current access right to its default setting. 

 Double-click on an access right to cycle through the three edit 

modes (Allow, Prevent, and Default). 

 When the desired access level is created, click the Save button.  The custom level is 

now available for use and appears in the Access Levels drop down list. 

 Click Undo to undo changes made in the Access Level tab only. 

To save or discard changes: 

 Click the OK button to save all changes made in the Administrator screen. 

 Click the Cancel button to discard all changes made in the Administrator screen. 

Access Level Definitions 

Acknowledge Alarms – Allows ability to acknowledge alarms. 

Administer System – Allows access to the Customize menu's Administrator and 

Contact Information screens. 

Allow Copy – Allows user to copy and paste from within @ptitude Analyst windows. 

Allow Print – Allows user to print from @ptitude Analyst windows using the File menu’s 

Print option. 

Analyze Data – Allows access to advanced cursors (i.e., sideband, harmonic, diagnostic, 

etc.). 

Create New Notes – Allows access to the Insert Notes screen to create new notes and 

view existing notes. Operator is the default. Once saved, the note becomes read only 

and cannot be edited or removed by the Operator. 

Delete Hierarchy Item – Allows access to remove items from the hierarchy. 

DMx Transfer – Allows access to the Transfer / DMx  dialogs. 

Export Analyst Data – Allows access to the File menu's Export / Analyst Data options. 

Export XML – Allows access to the Customize menu’s Configure XML Export option. 

Import Analyst  Data - Allows access to the File menu's Import / Analyst Data option. 

Manage Database – Allows access to various Customize menus options, including 

Database, Frequency Sets, Alarm Database, Statistical Alarms, and Filters. 
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Manage HMI displays – Allows access to various HMI Display window options, 

including Configure, Add, Remove, and Properties. 

Manage Measurements – Allows access to various Edit menu operations, including 

Cut, Paste, Delete, Set Baseline, and Properties. 

Manual Entry – Allows access to the Manual Entry dialog. 

MARLIN Administrator – Gives the user administrative rights on the MARLIN data 

manager. 

MARLIN Download – Allows access to the Transfer menu's MARLIN / Download tab. 

MARLIN Upload - Allows access to the Transfer menu's MARLIN / Upload tab. 

Microlog Analyzer Transfer – Allows access to the Transfer menu's Microlog option. 

Modify Alarm Setup – Allows modifications only to a POINT’s alarm settings, and 

prevents modifications to all other POINT attributes.   

 Modify Hierarchy access level must be disabled. 

Modify Assignment for Shared Reports - Allows specification of the report location for 

a shared report definition. 

Modify Firmware – Allows the user to import a new version of the IMx firmware into 

the @ptitude Analyst database (for automatic download to the device) using the File 

menu’s Import / Firmware option. 

Modify Global Preferences – Allows modification of global preferences. 

Modify Hierarchy – Allows access to various File, Edit, and Import menu operations, 

including New, Import, Manual Archive, Cut, Paste, Paste Multiple, Delete, 

Attributes, Properties, New Group, New POINT, Apply Template, Notes, Insert 

Item. 

Modify Notes – Allows access to the Insert Notes screen to create new notes and 

modify or remove existing notes. (This access is included in Modify Hierarchy.) Analyst is 

the default. 

Modify Inspection Alarm – Allows access to modify inspection prompts and results for 

an Inspection POINT after inspection data has been collection. 

Modify Operators – Allows access to add, modify, or remove operators on the 

Customize / Database screen’s Operators tab. 

Modify Operator Settings – Allows modification of operator settings.  

Modify Operators – Allows user to add and remove operators and modify operator 

sets. 

Modify Private Report - Allows modification of private report settings 

Modify ROUTE – Allows access to various Edit and Insert menu operations, including 

Cut, Paste, Paste Multiple, Delete, Properties, New Group, New POINT, and Insert 

Item. 

Modify Scheduler – Allows modification to scheduled events in Scheduler. 

Modify Shared Report - Allows modification of shared report settings. 
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Modify Template - Allows access to various Edit and Insert menu operations, including 

Cut, Paste, Paste Multiple, Delete, Properties, New Group, New POINT, and Insert 

Item. 

Modify Transient - Allows access to various Edit and Insert menu operations, 

including Cut, Paste, Paste Multiple, Delete, Properties, and New Group for 

Transient workspace definition.  Also allows access to define and download Transient 

data acquisition parameters for Transient data groups. 

Modify Workspace - Allows access to various Edit and Insert menu operations, 

including Cut, Paste, Paste Multiple, Delete, Properties, New Group, Apply Filter, 

and Reapply Filter. 

Online Transfer – Allows the user to upload and download data using the Online 

Transfer screen. 

Override Live Data Collection – Allows modification of a POINT during live data 

collection. 

Reset Indicators – Allows user to reset the status indicators in the status bar. 

View Data – Allows access to Alarm Details, plots, and plot overlays. 

View Database Hierarchy – Allows access to the Hierarchy window, Alarms window, 

and Go To Hierarchy context menu option. 

View Multiple Hierarchy – Allows user to open multiple hierarchies in the hierarchy 

window. 

View Report – Allows access to the File menu's Report option. 

View ROUTE – Allows access to the View menu’s ROUTE option. 

View System Information – Allows access to the View menus' System Information 

option. 

View Template – Allows access to the View menu's Template option. 

View Transient – Allows access to the Transient Workspace view and associated 

transient events. 

View Workspace – Allows access to the View menu's Workspace and Alarms option. 

Setting Your @ptitude Analyst Preferences 

Once you have installed your @ptitude Analyst software, it is time for you to “set up” or 

customize your @ptitude Analyst software for your applications.  The @ptitude Analyst 

Customize menu’s Preferences options allow you to customize @ptitude Analyst’s 

settings.   

Typical preference screen operations: 

 Click OK to save changes and exit screen. 

 Click Cancel to undo all edits since last Apply.    
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 Click Apply to view the preference setting changes made in a tab without closing 

the screen.  Affected views update, allowing you to observe your new preference 

settings before exiting the screen. 

@ptitude Analyst Preferences options include: 

General preferences 

Global preferences 

Measurement preferences 

Colors preferences 

Plot preferences 

WMx Non-collection preferences 

General Preferences 

Use the Customize menu’s Preferences option to display the Preferences / General 

tab. 

 

Figure 2 - 30. 

The Preferences Screen’s General Tab. 
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To change an individual setting’s status: 

 Click the setting to select it. 

 Select the desired preference setting from the Value drop down list. 

 Double-click each setting in the Settings: area to cycle through its 

values. 

 Refer to the appropriate product-specific manuals for more 

information on available general preferences. 

Allow multiple hierarchy support on DADs – Determines whether @ptitude Analyst 

allows DADs to download ROUTEs from more than one hierarchy, or to upload ROUTEs 

to more than one hierarchy.  Select Allow to enable multiple hierarchy support.  Select 

Don't Allow to disable multiple hierarchy support.   

 If multiple hierarchy support is enabled, ensure all data on the 

DAD is from the same Oracle database to prevent possible data 

corruption. 

Angular axis view – Determines the 0 reference point to define probe placement for 

Orbit, Bode, and Nyquist plots.  Choose Scientific or Standard. (@ptitude Analyst only.) 

 

Figure 2 - 31. 

Diagram Showing Scientific vs. Standard. 

Scientific – All internal calculations use the scientific mode.  In scientific mode, 

the 0 reference point is at the 3 o’clock position.  Measures from 0 to 360 

degrees. 

Standard – For viewing purposes only.  In standard mode, the 0 reference 

point is at the 12 o’clock position.  Measures from 0 to +/- 180 degrees. 

Arrange all windows layout – Allows you to customize how your @ptitude Analyst 

windows display when you select the Window menu’s Arrange All Windows option.  

Select Column, Matrix, or Row. 

Auto Link enabled message - Determines whether a message dialog displays 

informing you that auto link mode is enabled each time you navigate using the next / 

previous POINT and/or next / previous measurement toolbar buttons.  Auto Link 

associates and automatically updates each target window with the selected item in the 

source window.  Select On or Off. 
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Cloned group message – When groups are inserted into Workspaces or ROUTEs using 

copy and paste or drag and drop operations, the inserted group is a copy (clone) of the 

original group.  The Workspace or ROUTE group is not a reference to the original.  Edits 

to the copy (clone) do not affect the original group, except when a POINT’s 

“Properties” are edited.  Enable the Notify cloned group feature to display a “cloned 

group” reminder dialog when drag and drop or copy and paste operations are used. 

Compliance Interval mismatch message – Enable to display a message if there is a 

conflict between the data collection schedule for a ROUTE and the compliance schedule 

for a POINT within the ROUTE. (@ptitude Analyst only.) 

Display machine priority in color – Enable to display a machine priority color in the 

hierarchy for all machines with assigned priority levels.  Machine priority colors are 

assigned on the Customize / Preferences / Colors tab. 

Display measurement precision - In the hierarchy list and reports, controls the 

number of decimal places used for a measurement’s overall value.   

Display measurement status in detail list - Enable to display a measurement's status 

(baseline, current, archived, etc.) in the Hierarchy window detail list. 

Display multiple hierarchy warning –Select On to display a Multiple Hierarchy 

warning dialog when a download or upload is initiated involving multiple hierarchies.  

The warning message reminds you the DAD you are downloading to, or uploading from, 

has data from multiple hierarchies.  You are also reminded to ensure all data is from the 

same Oracle database.  Select Off to disable the warning message. 

Download POINT setup changes – Determines whether POINTs are automatically 

downloaded to online devices when changes are made to POINT setup.  Options are 

Download upon change or Do not download upon change. 

Frequency Units – Select the frequency value display units (Hz or CPM). 

MARLIN sync data - Determines whether @ptitude Analyst automatically detects a 

MARLIN connection, and begins uploading data from the MARLIN to @ptitude Analyst, 

clearing the MARLIN device of current ROUTE data, and downloading new ROUTE data 

to the MARLIN.  Select On or Off. 

Measurement date/time display options – Displays date and time or date only. 

Online notify download message – Determines whether to display a reminder 

message when changes are made to shared alarms stating that POINTs using the 

alarms should be re-downloaded to online devices. 

Open view in maximized mode – Determines whether @ptitude Analyst  displays in 

maximized mode (full screen size) when opened. 

Process MARLIN initiated upload – Determines whether @ptitude Analyst 

automatically processes MARLIN initiated upload data when detected in the specified 

LAN location.  The LAN location is specified in the Transfer screen's Status tab. 

 This preference setting applies to the current user only and is not 

a global setting.   

Restart DMx host message – When changes are made to DMx Device, Connection, or 

Host settings, changes are not applied until the Monitor application for the associated 
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host is restarted.  Select On to display a warning message when changes are saved.  

Select Off to bypass the message. 

Save filtered workspace on close – When a filter is applied, the results display in a 

new Workspace window.  When the window is closed, this preference setting 

determines how the filtered results are stored.  Three options are available: 

Always save – Select this option to automatically save the filtered workspace 

in the database when the Workspace is closed.  Filter results are saved as a 

standard Workspace. 

Ask to save – Select this option to display a dialog, requiring you to make a 

selection to save or discard the filtered results when the Workspace is closed. 

Do not save – Select this option to automatically discard the filtered 

workspace when closed.  The filtered results will not be available again until the 

same filter is re-applied. 

Shared expression modification message – Enable to display a message when 

changes are made to shared settings (such as shared alarms) advising the user to 

download settings to the DAD.   

Show POINT setup issues - Displays the POINT Setup Validation dialog if 

recommendation or error messages are necessary after setting up your POINT.  Select 

to display All POINT setup issues, or Errors only if you only wish to be prompted for 

errors.  

Show Work Notification Validation - Enable to automatically display a message 

prompting you to view the warnings associated with your work notification entries on 

the Work Notification dialog. Select On to enable and display the message, select Off 

to disable the warning message. 

Transient download notification message – When downloading DMx transient data 

setup to SKF @ptitude Analyst Monitor, you have the option to display a confirmation 

message notifying you when the download is complete.  Select On to display the 

message, or Off to bypass the message. 

User without hierarchy access message – When setting up user accounts, if a user is 

not given access to at least one hierarchy, the user is not able to log into @ptitude 

Analyst.  Select On to display a warning message when this occurs.  Select Off to allow 

users without hierarchy access to be created with no warning.  

Work notification approve message – When approving work notifications, the 

Approve All setting does not impact work notifications with the status Incomplete, 

Submitted or In queue.  Select On to display a message notifying users of this if 

Approve All is selected with items that will be ignored.  Select Off to bypass the 

message. 

Work notification remove message - When removing work notifications, the Remove 

All setting does not apply to work notifications with the status In queue.  Select On to 

display a message notifying users of this when Remove All is selected with items In 

Queue.  Select Off to bypass the message. 
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Global Preferences 

Use the Customize menu’s Preferences option to display the Preferences / Global tab.  

The Global tab allows you to set the preferences for resetting alarms that have been 

acknowledged, setting alarm limits verifications, setting configuration logging, etc.  This 

setting applies to all users. 

 

Figure 2 - 32. 

The Preferences Screen’s Global Tab. 

Auto generate non-collection event note – Specify Always, Never, or On Change.  

Default is On Change. 

Always - Notes are automatically generated and displayed on the trend plot for 

each type of non-collection event.   

Never – Notes are never displayed on the trend plot for non-collection events. 

On Change – Notes are only displayed for the first non-collection event and 

then again when the event goes back to normal. 

Clear cached data in IMx on connection – If the IMx was previously connected to a 

different location or you do not wish to keep the previously collected data, you may clear 

the cached data on the IMx upon connection.  Select On or Off. 

Collect IMx data when BOV is back in range - When On, when a BOV out of range 

event condition is cleared for an IMx POINT, unscheduled measurements are collected 
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for the POINT (i.e., Overall, FFT, and BOV), indicating that the non-collection event has 

returned to normal.  Select On or Off.  Default is Off. 

Days (0 to forever) to keep setup log records – Enter a number of days to store 

configuration log records.   

Default ADMIN password on the Microlog Inspector –Specify a new default password 

for the Microlog Inspector’s ADMIN user.  Default is “skf.” 

Display icon indicator when icon is overdue – When On, overdue icon indicator 

displays in hierarchy window next to overdue POINT.  Select On or Off. 

Enter reason for setup change on logging – Specify Allow Cancel, Always, or Never. 

Allow Cancel - Allow user to cancel entering a message for configuration 

change. 

Always - Requires user to enter a reason upon making any configuration 

changes 

Never - Does not prompt user to enter a reason for making configuration 

changes. 

Hysteresis verification into alarm – Enter the number of times in a row that 

measurements must go into alarm before host is notified of the alarm status.  The 

alarm status is not counted if the alarm status changes (i.e., alert to danger). 

Hysteresis verification out of alarm – Enter the number of times in a row that 

measurements must no longer be in alarm before the host is notified of the alarm 

status.  If subsequent alarms occur, the IMx is again triggered to collect data. 

IMx post-processing interval in minutes – Determines how often @ptitude Analyst 

uploads data from the IMx and evaluates the alarms. Default is 15 minutes.  Enter the 

number of minutes of how often post-processing occurs. 

 The smaller the interval, the greater the network traffic from the 

IMx devices to SKF IMx Service. 

Log POINT setup changes – Stores all configuration log records.  Select On or Off. 

Microlog Inspector photo upload directory - Enter the path to where photos from 

Microlog Inspector are uploaded. 

 If you do not specify a directory, the system hosting the Microlog 

Service’s ProgramData directory will be used (e.g., [Path to 

ProgramData]\SKF\@ptitude Analyst\Microlog\Inspector\MEDIA). 

 The Windows user the Microlog Service is running under must 

have write access to the specified directory.  If the Windows user 

doesn't have write access, the default ProgramData directory will 

be used instead. 

Overdue processing delay between POINTs in seconds – Background processing 

checks each POINT to determine if it is overdue.  Enter the number of seconds to wait 

before proceeding to the next POINT. 

Percent beyond schedule to report online POINT as overdue – Enter a percent for 

how overdue a POINT should be before it is reported as overdue.  
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Set alarm to not acknowledged - Determines when a previously acknowledged alarm 

will return to a not acknowledged state.  

Set to not acknowledged whenever alarm level is changed – When a 

previously acknowledged alarm level changes (higher or lower), the alarm’s 

acknowledged status returns to not acknowledged. 

Set to not acknowledged only when alarm level goes higher – When a 

previously acknowledged alarm level goes higher, the alarm’s acknowledged 

status returns to not acknowledged. 

Store IMx “BOV out of range” non-collection events – Determines when a BOV out 

of range non-collection event should be stored for IMx POINTs.  Select Always, Never, 

or On Change.  Default is Always. 

Always – When a non-collection event occurs, non-collection data is always 

recorded for the POINT.  Also, if the Collect IMx data when BOV is back in 

range preference is enabled, when the event condition is cleared, unscheduled 

measurements are collected for the POINT (i.e., Overall, FFT, and BOV), 

indicating that the non-collection event has returned to normal.   

Never – When a non-collection event occurs, non-collection data is never 

recorded for the POINT.  Also, if the Collect IMx data when BOV is back in 

range preference is enabled, when the event condition is cleared, unscheduled 

measurements are collected for the POINT (i.e., Overall, FFT, and BOV), 

indicating that the non-collection event has returned to normal.    

On Change – Non-collection data is only recorded the first time a non-

collection event occurs.  Also, if the Collect IMx data when BOV is back in 

range preference is enabled, when the event condition is cleared, unscheduled 

measurements are collected for the POINT (i.e., Overall, FFT, and BOV), 

indicating that the non-collection event has returned to normal.   

Store IMx “Outside of threshold range” non-collection events - Determines when a 

threshold out of range non-collection event should be stored for IMx POINTs.  Select 

Always, Never, or On Change.  Default is Always. 

Always – When a non-collection event occurs, non-collection data is always 

recorded for the POINT.   

Never – When a non-collection event occurs, non-collection data is never 

recorded for the POINT.   

On Change – Non-collection data is only recorded the first time a non-

collection event occurs. 
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Measurement Preferences 

Use the Customize menu’s Preferences option to display the Preferences / 

Measurement tab. 

 

Figure 2 - 33. 

The Preferences Screen’s Measurement Tab. 

Measurement data to display – Determines the type of data to display in the 

Hierarchy list.  Click checkboxes to select / deselect.  Options include: 

Current data – Data collected via manual entry or Data Acquisition Device. 

Baseline data – A POINT’s measurement record tagged as its baseline 

measurement (in the POINT Properties screen).  The baseline spectrum is a 

spectrum taken when the machine was in known good running order and is 

used for comparison to current spectra. 
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Unscheduled – Data collected automatically by a DAD (typically an on-line 

system) due to an alarm condition that is not part of a normally scheduled data 

collection. 

Short term archived data – Data manually or automatically short term 

archived. 

Long term archived data – Data manually or automatically long term 

archived. 

Waveform data – Data specified as the slow roll waveform measurement. 

Non-collection data – Data collected by an IMx / WMx due to an event that 

occurs preventing the measurement POINT from being collected.  Examples of 

non-collection events include when the IMx / WMx BOV is out of range, when 

the WMx trigger times out, or when the WMx POINT’s gating condition does 

not match the gating settings.  Non-collection data displays a non-collection 

event’s date / time, summary (i.e., Not collected, BOV (Current)), and an 

overall description (i.e., BOV out of range). 

Four selections allow further specification of data display.   

 Select “All measurements matching the criteria above” to display all 

measurements matching the selected items in the Measurement data to display 

list.   

 Select “Measurement matching the criteria above since the date” and enter the 

desired date to display all measurements matching the selected items in the 

Measurement data to display list since the specified date only. 

 Select “Last number of measurements matching the criteria above” and specify 

a number to display a customized number of measurements matching the selected 

items in the Measurement data to display list (as specified by the number 

entered). 

 Select “Measurements matching the criteria above within the date range” and 

enter the desired date range to only display measurements matching the selected 

item in the Measurement data to display list within the specified date range. 
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Color Display Preferences 

The Preferences screen’s Colors tab allows you to change colors of items appearing in 

graphic display plots and in the colors of alarm indicators (on hierarchy lists and in 

graphic displays). 

 

Figure 2 - 34. 

The Preferences Screen’s Colors Tab. 

All color setting names and their categories appear in the tab.  Each Setting is detailed 

later in this section. 

 Click a Setting to select it.  The Setting’s current color appears in the large color 

box.  The setting’s default color appears in the smaller color box. 

 Click the Default button to restore the setting’s color to the default color. 

 To change the setting’s color, select a new color from the color menu (colored 

squares at the bottom of the tab).  Double-click a color square to create a 

customized color. 

 Click the Apply button.  The new color preference setting takes effect immediately. 

 To make all colors revert to their default settings, click the Default All button. 
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 Click OK to save changes. 

 Click Cancel to discard changes. 

You may add more cursors and traces for use on plots, and define colors for the new 

cursors and traces.   

To add more cursor or trace color settings: 

 Click in the cursor or trace category group. 

 Click the Add button. 

 A new cursor or trace appears, identified by a “.” and followed by the next 

sequential number in the list. 

 Specify the color for the new setting. 

 Click Apply. 

To remove an added cursor or trace setting: 

 Click the setting to select it. 

 Click the Remove button. 

 Click Apply. 

 Click the OK button to save all changes made in the screen. 

 Click Cancel to discard all changes. 

 Refer to the appropriate product-specific manuals for more 

information on available color preferences. 

Individual color display settings: 

Active title 

Determines the color of the title of the active plot.  The active title distinguishes 

the active (primary) plot from the inactive (secondary) plot when you are 

viewing a combination plot. 

Active Trace 

Determines the color of the active spectrum. 

Aged Data 

Determines the color for aged data in a live bar display.  Data is considered 

“aged” if it no new data is received for a time period exceeding the value 

specified in the Data Aged Time (Minutes) plot preference. 

Alert 

Determines the alert alarm color. 

 Alert alarm color displays in the Hierarchy for POINTs in alert 

alarm, alarm lines in plots, and in the POINT Properties' Overall 

Alarm tab. 



  Getting Around in SKF @ptitude Analyst 

 Setting Your @ptitude Analyst Preferences 

SKF @ptitude Analyst Introduction  2 - 65 

User Manual 

Alert (Text) 

Determines alert alarm text color in the POINT Properties' Overall Alarm 

tab's alarm graphic. 

Band Alarm 

Determines the color of band frequency lines. 

Channel-Bad 

Determines the color of the bad channel status indicator on the Online screen's 

Status tab, indicating the sensor's status. If the sensor voltage is outside the 

range specified in the sensor setup, it is considered a bad channel. 

Channel-Bad (Text) 

Determines the color of the text indicating the bad channel number in the 

Online screen's Status tab's Channel Status area. 

Channel-Good 

Determines the color of the good channel status indicator on the Online 

screen's Status tab, indicating the sensor's status. If the sensor voltage is 

within the range specified in the sensor setup, it is considered a good channel. 

Channel-Good (Text) 

Determines the color of the text indicating the good channel number in the 

Online screen's Status tab's Channel Status area. 

Clear 

Determines the color of processed alarm not in alert or danger. 

 Clear alarm color displays in the Hierarchy for POINTs with clear 

processed alarms, and in the POINT Properties' Overall Alarm 

tab. 

Clear (Text) 

Determines clear alarm text color in the POINT Properties' Overall Alarm 

tab's alarm graphic. 

Cursor Line Focus 

Determines the color of the current line selection icon. 

Cursor.# 

Determines individual colors in the repeating sequence of cursor colors. 

 This icon is used on overlays with multiple cursor lines, such as a 

band cursor. 

Danger 

Determines danger alarm color. 

 Danger alarm color displays in the Hierarchy for POINTs in 

danger alarm, alarm lines, and in the POINT Properties' Overall 

Alarm tab. 
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Danger (Text) 

Determines danger alarm text color in the POINT Properties' Overall Alarm 

tab. 

Download Progress 

Determines the color of the download progress bar that displays in the online 

connection status area during a download. 

Frequency.# 

Determines the frequency marker color displayed on the spectrum plot. 

Frequency Bar – Speed Reference Out of Range 

Determines the default color of a frequency bar in a Contribution plot when the 

associated speed reference is an external speed POINT that has a 

date/timestamp outside of the specified speed reference time window. The 

default color cannot be one of the default Overall Alarm colors (Green, Yellow 

and Red). 

Frequency Bar  – Speed Reference Within Range 

Determines the default color of a frequency bar in a Contribution plot when the 

associated speed reference has a date/timestamp within the specified speed 

reference time window. The default color cannot be one of the default Overall 

Alarm colors (Green, Yellow and Red). 

Grid Background 

Determines plot's background color. 

Grid Line Labels 

Determines color of the axis labels displaying on the perimeter of a plot. 

Grid Lines 

Determines the color of plot's grid lines. 

Inactive Title 

Determines the color of the title of the inactive plot.  The active title 

distinguishes the active (primary) plot from the inactive (secondary) plot when 

you are viewing a combination plot. 

Machine Priority # 

Determines individual colors of machine priority levels.  The machine priority 

color appears in the hierarchy for each machine assigned a priority. 

Mouse Information 

Determines the color of the text appearing in the plot feedback area's second 

line, displaying information related to the current mouse position. 

Notes On Trend – Active Line / Inactive Line 

Determines the color of the active / inactive note on a plot.   
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Overlay Information 

Determines the color of the text appearing in the plot feedback area's first line, 

displaying information related to the active overlay. 

Plot Grid Title 

Determines the color of the title of the plot’s grid.   

Plot Window Background 

Determines color of the plot window background (the area outside of the plot 

grid). 

Running Speed 

Determines the running speed overlay color. 

System Indicator-Clear 

Determines the color of the system indicator icon when in the system is in clear 

mode. 

System Indicator-Problem 

Determines the color of the system indicator icon when a system problem is  

detected. 

System Indicator - Problem (Text) 

Determines the color of the system indicator text when a system problem is 

detected. 

Trace.# 

Determines individual colors of the plotted data in the repeating sequence of 

trace colors. 

Trend Curve Fit 

Determines curve fit overlay line color. 
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Plot Display Preferences 

Use the Customize menu’s Preferences option to display the Preferences / Plot tab 

and enable or disable individual plot display settings. 

 

Figure 2 - 35. 

The Preferences Screen’s Plot Tab. 

 Refer to the appropriate product-specific manuals for more 

information on available plot preferences. 

Individual plot settings include: 

Autoscale / Nyquist 

On / Off – Enable to scale nyquist plots to the data. Disable to use the full scale 

value. 

Autoscale / Orbit  

On / Off – Enable to scale orbit plots to the data. Disable to use the full scale 

value. 

 When orbit plots are scaled, they retain their relative proportions 

so the center point of the plot remains zero. 
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Autoscale / Roundness Profile 

On / Off – Enable to scale roundness profile plots to the data. Disable to 

use the full scale value. 

Autoscale / Shaft Centerline  

On / Off – Enable to scale shaft centerline plots to the data. Disable to use the 

full scale value. 

Band Alarm / Band Trend 

On / Off – Enable / disable automatic band alarm display on band trend plots. 

 Default status on open is on.   

Band Alarm / Spectrum 

On / Off – Enable / disable automatic band alarm display on spectrum plots. 

 Default status on open is on. 

Band Alarm Display / All Plots 

Overall / Peak / Peak and Overall – Determines the type of band alarms to 

display on plots that have band alarms enabled.  Select Overall to only display 

band alarms on the overall alert and danger levels.  Select Peak to only display 

band alarms on the peak alert and danger levels.  Select Peak and Overall to 

display both types of band alarms. 

 Preference changes immediately update on active plot. 

Band Cursor / Orbit  

On / Off – Enable or disable automatic band cursor display on the time plot 

section of orbit plots.  The band cursor isolates a section of the time waveform.  

The orbit section of the plot is filtered by the data within the band cursor. 

Band Cursor / Spectrum 

On / Off – Enable / disable automatic band cursor display on spectrum plots. 

 Default status on open is off. 

Band Cursor / Time 

On / Off – Enable / disable automatic band cursor display on time plots. 

 Default status on open is off. 

Band Cursor / Waterfall 

On / Off – Enable / disable automatic band cursor display on waterfall plots. 

 Default status on open is off. 

Bearing Clearance / Shaft Centerline 

On / Off  – Determines whether to include the bearing clearance overlay by 

default on shaft centerline plots. 

 Default status on open is on. 
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BOV Limit / BOV or Gap Trend  

On / Off – Enable / disable the BOV limit overlay on BOV or Gap trend plots. 

 Default status on open is on. 

Channel Number / All Plots 

All / Ask / Channel X Only – (@ptitude Analyst only) Determines which 

channel(s) display when opening a plot with multi-channel data (i.e., 2-channel, 

3-channel, and Orbit / SCL POINTs).  Options are to display All channels, which 

displays each channel using the Layout Orientation preference, display 

Channel X Only, or have the software Ask which channel(s) to display each 

time a plot is opened via a Select Channel Number dialog. 

 If Auto Link is turned on, this setting is overridden and all 

channels display.   

 This option also applies to plots in reports.  If this preference is set 

to Ask and you include multiple plots in your reports, you will 

receive a channel prompt for each plot when the report is 

generated.  If you frequently generate reports with a large 

number of plots, consider selecting the All Channel option for this 

preference to avoid multiple prompts. 

Compensation / Multiple Plots 

On / Off – Enable / disable automatic compensation display on Orbit, Bode, 

and Nyquist plots.  When enabled, plots are adjusted to filter out impurities in 

the shaft identified using either the slow roll waveform measurement (Orbit 

plots only) or vector compensation for filtered order data (Orbit, Bode, and 

Nyquist plots), both defined in POINT Properties.  

 Default status on open is off. 

Cursor Cross-Hashing / Time 

On / Off – Determines the degree of shading on band cursors in time plots.  If 

On is selected, the band is shaded with a cross-hatch.  If Off is selected, the 

band is shaded with single diagonal lines. 

 The Time – Band cursor’s fill pattern lines slope upward from left 

to right to distinguish it from a harmonic cursor.  A harmonic 

cursor’s fill pattern lines slope downward from left to right.  Cross 

hashing can be useful to help further distinguish a time band 

cursor from a harmonic band cursor.   

 Default status on open is off. 

Cursor Data Style / All Plots 

Box / Circle / Cross / Target – Determines the cursor symbol displayed when 

an overlay intercepts a date line. 

 Default status on open is Circle. 
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Cursor Line Style / All Plots 

Dashed (Full) / Dashed (Partial) / No Line / Solid (Partial) / Solid (Full)  – 

Determines the appearance of the overlay line. A “partial” line only reaches the 

peak of the data.  A “full” line reaches the bottom of the plot. 

 Default status on open is Solid (Full). 

Curve Fit / Trend 

On / Off – Enable / disable automatic curve fit display on trend plots. 

 Default status on open is Off. 

Damping Cursor / Bode 

On / Off – Enable / disable automatic damping cursor display on Bode plots. 

  Default status is On. 

Data Aged Time (Minutes) / Live Bar 

Enter Value – Enter the number of minutes data in a live bar display can 

remain static before it is considered outdated.  If no new data is received for a 

time period exceeding the entered value, the live bar changes color (based on 

the Aged Data Color Preference), indicating the data is old. 

Default Active Trace / Waterfall 

Last Measurement / Oldest Measurement - Determines whether the oldest 

or latest frequency is highlighted by default in Waterfall plots. 

Default Active Trace / Cascade 

Last Measurement / Oldest Measurement - Determines whether the oldest 

or latest frequency is highlighted by default in Cascade plots. 

Diagnostics / Spectrum 

On/ Off - Determines whether the diagnostic cursor is on by default when a 

spectrum plot is displayed.  

 Default status on open is off.  

Diagnostics Percentage / Spectrum 

Filters the list of harmonic patterns displayed with a spectrum plot’s diagnostic 

cursor, based on a percentage of the highest Activity Index detected in the 

spectrum.  (The Activity Index is a numeric value that quantifies the likelihood 

of harmonic patterns being present in a spectrum.  Higher numbers represent 

a greater likelihood of a true harmonic pattern.)  Only harmonic patterns that 

are greater than the specified percentage criterion display.  (For example, if the 

highest Activity Index is 3.5, a Diagnostics Percentage of 50% would filter out 

any harmonic patterns with an Activity Index below 1.75.)   

 Default Value is 30%. 

Envelope Alarm / Spectrum 

On / Off – Enable / disable automatic envelope alarm display inside spectrum 

plots. 
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 Default status on open is off. 

Exponential Curve Fit / Trend 

On / Off – Enable / disable exponential curve fit on trend plots. 

 Default status on open is off 

Filtering / Orbit 

Value – Used to apply vector order filters (defined on the POINT Properties 

screen’s Vector tab) to orbit plots.  Choices are 1x, 2x, 3x, and Unfiltered. 

 Default status on open is Unfiltered. 

Frequencies / Spectrum 

On / Off – Enable / disable automatic frequency overlay display on spectrum 

plots. 

 Default status on open is off 

Frequencies / Spectrum HAL Trend Plot Instance 

On / Off – Enable / disable automatic frequency overlay display on spectrum 

HAL trend plots. 

 Default status on open is off 

Frequency Bar Sort / Contribution 

Frequency name / % Contribution – Enable / disable the frequency marker 

border used by the Frequencies overlay.   

 Default status on open is Frequency name. 

Frequency Marker Border / Spectrum 

On / Off – Enable / disable the frequency marker border used by the 

Frequencies overlay.   

 Default status on open is on. 

Frequency Marker Border / Spectrum HAL Trend Plot Instance 

On / Off – Enable / disable the frequency marker border used by the 

Frequencies overlay.   

 Default status on open is on. 

Frequency Marker Default / Spectrum 

 On / Off – Enable / disable the frequency marker default display 

status used by the Frequencies overlay.  By default, the @ptitude 

Analyst frequencies overlay displays all frequency markers assigned 

to the active POINT, unless you have already configured your 

frequency overlay setting to display specific frequencies.  Using the 

Frequency Marker Default plot display preference setting, you can 

override @ptitude Analyst’s default frequency marker display so 

that no frequency markers display on the spectrum plot until you 

configure your frequency overlay settings. 
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Frequency Marker Default / Spectrum HAL Trend Plot Instance 

On / Off – Enable / disable the frequency marker default display status used by 

the Frequencies overlay.  By default, the @ptitude Analyst frequencies overlay 

displays all frequency markers assigned to the active POINT, unless you have 

already configured your frequency overlay setting to display specific 

frequencies.  Using the Frequency Marker Default plot display preference 

setting, you can override @ptitude Analyst’s default frequency marker display 

so that no frequency markers display on the spectrum plot until you configure 

your frequency overlay settings. 

Grid Line Labels / All Plots 

On / Off – Enable / disable automatic plot grid line labels display. 

 Preference changes immediately update on active plot. 

 Default status is On. 

Grid Lines / All Plots 

On / Off – Enable / disable automatic plot line display. 

 Preference changes immediately update on active plot. 

 Default status is On. 

HAL Alarm / Trend 

On / Off – Enable / disable automatic HAL alarm display on trend plots. 

 Default status on open is On. 

Harmonic Cursor / Time 

On / Off – Enable / disable automatic harmonic cursor display on time plots. 

 Default status on open is off. 

Harmonic Cursor / Spectrum 

On / Off – Enable / disable automatic harmonic cursor display on spectrum 

plots. 

 Default status on open is off. 

Information Area / All Plots 

Show / Hide – Enable / disable automatic information area display when plot is 

opened. 

 Default status on open is On. 

Inspection Cursor / Inspection 

On / Off – Enable / disable automatic inspection cursor display on inspection 

plots. 

 Default status is On. 
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Layout Orientation / Spectrum (Microlog) 

Stacked / Combined – Determine the plot orientation for multi-channel data 

in spectrum plots.  Stacked displays each channel as a separate plot.  

Combined shows a single plot overlaid with all channels. 

 Preference change only affects a plot when opened.  Changes do 

not immediately update. 

 Default status on open is Stacked. 

Layout Orientation / Spectrum (Microlog Inspector / MARLIN) 

Stacked / Combined – Determine the plot orientation for the two 

measurements collected by a WMCD (velocity and enveloped acceleration) in a 

spectrum plot.  Stacked displays each measurement as a separate plot.  

Combined shows a single plot overlaid with all measurements. 

 Preference change only affects a plot when opened.  Changes do 

not immediately update. 

 Default status on open is Stacked. 

Layout Orientation / MCD 

Stacked / Combined – Determine the display orientation for the three 

measurements collected by a Machine Condition Detector (velocity, enveloped 

acceleration, and temperature) in an MCD plot.  Stacked displays each 

measurement as a separate plot.  Combined shows a single plot overlaid with 

all measurements. 

 Preference change only affects a plot when opened.  Changes do 

not immediately update. 

 Default status on open is Stacked. 

Layout Orientation / Multiple Plots 

Side-by-Side / Stacked – Select the display orientation of window panes for 

extracted band, band trend, mag/speed/spectrum, mag/speed/time, trend / 

time, and trend / spectrum plots (all double-paned plots) when opened.  Side-

by-Side displays window panes next to each other.  Stacked displays window 

panes with one on top of the other. 

 Preference change only affects a plot when opened.  Changes do 

not immediately update. 

 Default status on open is Stacked. 

Linear Speed / Multiple Plots 

On / Off – Enable / disable automatic linear speed cursor display on 

Mag/Speed Trend, Orbit, spectrum, Time, and Trend plots. 

 Default status on open is off. 
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Live Bar Axis 

Select the live bar axis value for live bar graph displays. Available options 

include: 

Alarm Limit – Alert 

Alarm Limit – Danger 

Autoscale 

POINT Full Scale 

 The default setting is POINT Full Scale. 

Magnitude Maximum / Roundness Profile 

Enter the magnitude level to display on contribution roundness profile plots. 

 Default value on open is 5.  Negative values and values with 

decimal points are allowed. 

Magnitude Minimum / Roundness Profile 

Enter the magnitude level to display on contribution roundness profile plots. 

 Default value on open is 0. Negative values and values with 

decimal points are allowed. 

MCD Alarm 

On / Off – Enable / disable automatic MCD alarm display on MCD plots. 

 Default status on open is On.  

MCD Cursor 

On / Off – Enable / disable automatic MCD cursor display on MCD plots. 

 Default status on open is On. 

MCD Curve Fit Overlay 

On / Off – Enable / disable automatic MCD curve fit overlay display on MCD 

plots. 

 Default status on open is Off. 

Measurement Tagging / Multiple Plots 

None / Speed – Enable /disable speed tagging on measurements in shaft 

centerline and Nyquist plots.  If Speed is selected, the speed (in RPM) of the 

shaft at the time of the measurement appears next to each measurement on 

the plot. 

Notes  

On / Off – Enable / disable automatic Notes cursor display on Trend, MCD, and 

Inspection plots. 

 Default status on open is On. 
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Notes Indicator Location 

Top / Bottom - Determine where the notes indicator should display on the 

plot.   

Notes Indicator Tooltip 

On / Off – Enable / disable the display of the tooltip when the mouse cursor 

hovers over the notes indicator. 

Notes Line Style  

Dashed (Full) / Dashed (Partial) / No Line / Solid (Full) / Solid (Partial) - 

Determine how the notes line should display on the plot.  

Number of Harmonics / Multiple Plots 

Enter Value – Determine the number of harmonics (including cursor line) that 

display when a harmonic cursor is visible.  Enter a value between 1 and 100. 

 Preference changes immediately update on active plot. 

 Default value is 50. 

Number of Live Measurements / All Plots 

Enter Value – Determine the number of measurements that should be 

included in plots that display multiple measurements (e.g., trend and waterfall) 

when viewing live data.  When this number is reached, old data falls off as new 

data is received. 

 Default value is 50. 

Number of Sidebands / Spectrum 

Enter value – Determine the number of sidebands that display when a 

sideband cursor is visible. Enter a value between 1 and 100. 

 Preference changes immediately update on active plot. 

 Default value is 5. 

Oil Analysis / Trend 

On / Off – Determine whether the Oil Analysis overlay should be shown by 

default on trend plots. 

 Default value is Off. 

Overall Alarm / Mag/Speed Trend 

On / Off – Enable / disable automatic overall alarm display on Mag/Speed 

trend plots. 

 Default status on open is On. 

Overall Alarm / Trend 

On / Off – Enable / disable automatic overall alarm display on trend plots. 

 Default status on open is On. 
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Palogram Slant / Waterfall 

Enter Value – Determine palogram slant angle in Waterfall plot.  Enter value 

between 20 and 45. 

 Default value is 20. 

 Available only when waterfall plot displays in palogram mode. 

Peak Cursor / Orbit 

On / Off – Enable / disable automatic peak cursor display on the time section 

of orbit plots. 

Peak Cursor / Spectrum 

On / Off – Enable / disable automatic peak cursor display on spectrum plots. 

 Default status on open is off. 

Peak Cursor / Time 

On / Off – Enable / disable automatic peak cursor display on time plots. 

 Default status on open is off. 

Phase Alarm / Polar Vector 

On / Off – Enable / disable automatic phase alarm display inside polar vector 

plots. 

 Default status on open is on. 

Phase View / Bode 

Wrapping / Rolling – If the phase angle in a Bode plot exceeds 360˚, 

determines whether the data should wrap (return to 0) or roll (continue past 

360).  Choose Wrapping to have the data line beyond the phase axis range 

wrap around.  Choose Rolling to have the phase axis scale extend to keep the 

data line continuous. 

 Default value is Wrapping. 

Protection Threshold Limits / Trend 

On / Off – Enable / disable the protection threshold limits display on trend 

plots for IMx-M protection POINTs with protection threshold limits defined on 

the POINT Properties / Protection Threshold Levels tab.   

 Default status on open is Off. 

Revolutions (Band Cursor) / Orbit 

Value – Determine the default number of revolution that will display on orbit 

plots, based on the size of the band cursor overlay.  Select from 1 – 5 

revolutions, or All. 

 Default status on open is All. 
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Running Speed / Spectrum 

On / Off – Enable / disable automatic running speed display on spectrum plots. 

 Default status on open is on. 

Running Speed / Trend 

On / Off – Enable / disable automatic running speed display on trend plots. 

 Default status on open is on. 

Running Speed Line / Spectrum 

On / Off – Enable / disable automatic running speed line display on spectrum 

plots. 

 Default status on open is off. 

Save Live Data Type / All Plots 

All Types / Plot Type – When a live data plot is displayed, determines whether 

the online system continues to collect all data types, or only collects data that 

corresponds to the plot type.  For example, if a Trend plot is open with Plot 

Type is selected, only overall data is collected.  (This option is used to speed 

data collection.) 

 Default status is All Types. 

 Be aware that speed is retrieved from the dynamic data.  If a 

POINT has a speed alarm defined and this is set to Plot Type, live 

bars will not be able to adjust the overall alarms based on speed 

for some plot types. 

 The communication speed of the DMx Machine Monitoring 

Module is restricted for IS compliance, resulting in slower data 

collection than some other online systems.  If you are using the 

DMx, consider setting this to Plot Type to boost performance of 

the live data display. 

Sideband Cursor / Spectrum 

On / Off – Enable / disable automatic sideband cursor display on spectrum 

plots. 

 Default status on open is on. 

Single Cursor / Multiple Plots 

On / Off – Enable / disable automatic single cursor display on band trend, 

bode, cascade, extracted band, extracted trend, mag/phase trend, mag/speed 

trend, Nyquist, orbit, polar vector, shaft centerline, spectrum, time, topology, 

trend, and waterfall plots. 

 Default status on open in on.  

Single Cursor Position / Spectrum 

Highest Peak / 1X Speed / POINT Setup –Determines the initial position of 

the single cursor when displayed on a spectrum plot.  When set to “Highest 

Peak”, the cursor is positioned at the highest peak location.  When set to “1X 
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Speed”, the cursor position corresponds with the spectrum’s running speed.  

When set to “POINT Setup”, the cursor position corresponds to the running 

speed value entered in the POINT’s Setup tab. 

 Default status on open is Highest Peak. 

Speed Reference Time Window (Unit) / Contribution 

Hours / Minutes / Seconds – Determines the unit of time used to calculate 

the contribution plot.  

 Default unit is Hours. 

Speed Reference Time Window (Value) / Contribution 

Determines the amount of time to use to calculate the contribution plot.  The 

maximum allowable value is 48 hours; this is equivalent to 2880 minutes or 

172800 seconds. 

 Default value is 24. 

Stack Mode / Spectrum 

Link / Unlink – If Layout Orientation / Spectrum is set to Stacked, determine 

whether cursors and overlays are linked across all plots, or operate 

independently.  If Link is selected, cursors and overlays appear in the same 

position across all plots.  If Unlink is selected, you may add and move cursors 

and overlays in each plot independently. 

 Default status is Link. 

Threshold % / All Plots 

Enter Value – Determine the default placement of the peak cursor threshold.  

Enter a percent value between 0% and 100%.  This is also used by the 

Envelope alarm tab to set the alarm threshold value. 

 Default value is 10%. 

Time Coordinates / Time 

Seconds / Milliseconds – Determines the time plot’s x-axis units. 

 Default status on open is Seconds. 

Waterfall Mode / Waterfall 

Waterfall / Palogram – Determine if initial display mode of waterfall plot is 

waterfall or palogram. 

 Default status on open is waterfall. 

 When a waterfall or palogram plot is open, use Waterfall 

Settings to customize display. 

Waterfall Slant / Waterfall 

Enter Value – Determine the waterfall slant angle in Waterfall and Cascade 

plots.  Enter value between 45 and 90. 

 Default value is 70. 
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 Available only when waterfall plot displays in waterfall mode. 

Waterfall Spacing / Waterfall 

By Date / Equally Spaced – Determine the waterfall plot data display mode.  

By date – Data grouped by date. 

Equally Spaced – Each line evenly spaced. 

 Default status on open is By Date. 

 When a waterfall plot is open, use Waterfall Settings to 

customize display. 

X-Axis Units / All Plots  

Frequencies / Orders / POINT Specific – Determine the x-axis display mode 

used in spectrum, waterfall, cascade, and topology plots. 

 Preference changes immediately update on active plot. 

 Default setting is orders. 

Y-Axis Autoscale / Multiple Plots 

On / Off – Enable to scale the Y axis of Bode, MCD, spectrum, time, and trend 

plots to data. Disable to use full scale value. 

Y-Scaling / All Plots 

Linear / Logarithmic – Determine the Y axis display mode, Linear or 

Logarithmic. 

Default status on open is Linear. 

WMx Non-Collection Preferences 

Use the Customize menu’s Preferences option to display the Preferences / WMx Non-

collection tab and enable or disable individual WMx non-collection event settings.   



  Getting Around in SKF @ptitude Analyst 

 Setting Your @ptitude Analyst Preferences 

SKF @ptitude Analyst Introduction  2 - 81 

User Manual 

 

Figure 2 - 36. 

The Preferences Screen’s WMx Non-Collection Tab. 

For the following preferences, select Always, Never, or On Change.  Default is Always. 

Always – When a non-collection event occurs, non-collection data is always 

recorded for the WMx POINT.   

Never – When a non-collection event occurs, non-collection data is never 

recorded for the WMx POINT. 

On Change – Non-collection data is only recorded the first time a non-

collection event occurs.  When the event returns to normal, regular 

measurements are recorded for the WMx POINT again. 

WMx BOV out of range – Determines when a BOV out of range non-collection event 

should be stored for WMx POINTs.   

WMx Threshold out of range - Determines when a threshold out of range non-

collection event should be stored for WMx POINTs.  

WMx channel overload – Determines when a channel overload event should be stored 

for WMx POINTs.  A channel overload event occurs if the input exceeds the maximum 

input voltage range (i.e., when there is an open circuit at the DC input terminals, an 

overload event may occur). 
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WMx hardware failure – Determines when a WMx hardware failure event should be 

stored for WMX POINTs.   

WMx incorrect gates – Determines when an incorrect gates event should be stored for 

WMX POINTs.  An incorrect gates event occurs when the actual gating condition does 

not match the gating settings. 

WMx incorrect sample – Determines when an incorrect sample event should be stored 

for WMx POINTs.  This indicates that POINT setup requires more memory than is 

available in the WMx.  This non-collection event is unlikely to occur, since @ptitude 

Analyst always validates the POINT setup. 

WMx invalid orders – Not applicable. 

WMx trigger glitch – Determines when a trigger glitch event should be stored for WMx 

POINTs.  A trigger glitch occurs when the tachometer input is greater than 10 kH. 

WMx trigger timeout – Determines when a trigger timeout event is stored for the 

WMx POINTs.  When a trigger timeout event occurs, the WMx aborts the measurement. 

Exiting SKF @ptitude Analyst 

To exit SKF @ptitude Analyst: 

 Select the File menu's Exit option, or 

 Double-click the Main window's Control Menu box, or 

 Press Alt / F4.
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SKF @ptitude Analyst Monitor Application 

Monitor Application Overview 

@ptitude Analyst’s Monitor program is a support application that runs in the 

“background.”  While running, a Monitor icon displays on the Window’s icon tray. 

The Monitor application performs continuous operations that require little or no user 

interface, such as retrieving data from on-line systems and DMx modules, creating 

work notifications in a CMMS, and archiving data as set in each POINT’s POINT 

Properties / Schedule tab.  In conjunction with Analyst’s Scheduler feature, the 

Analyst Scheduler also utilizes the Monitor application as specified in the Scheduler 

wizard, to facilitate scheduled archiving. 

 This user manual does not describe the work notification feature.  

For details on how to create work notifications, reference the SKF 

@ptitude Analyst CMSW 7302 User Manual. 

SKF @ptitude Analyst Monitor Window 

The Monitor window displays online connection information, if available.  Displayed 

information includes: 

User – The computer name associated with the connection. 

Connection Type – The type and purpose of the connection. 

Time – The time the connection was established. 

Date – The date the connection was established. 

SKF @ptitude Monitor Recovery Service 

If Monitor loses connection with the database server, Monitor will automatically shut 

down and try to reconnect to the server every 15 minutes by default.   

If you wish to change the interval for which Monitor tries to reconnect, you may 

configure it through the registry using the following path: 

Hkey_Local_Machine\software\SKF Condition Monitoring\SKF Machine 

Analyst\Application Settings\Monitor Recovery Interval 
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Working with @ptitude Analyst Monitor 

@ptitude Analsyt Monitor performs measurement operations in two ways: 

continuously and scheduled.  Each method is detailed below: 

Monitor – Continuous Mode 

To run Monitor continuously: 

 From your Windows start menu, select the SKF @ptitude Analyst group’s SKF 

@ptitude Analyst Monitor option.  

 You may also double-click the executable file monitor.exe to run 

the Monitor application. 

@ptitude Analyst Monitor will run continuously until you close the application. 

 
While running, the @ptitude Analyst Monitor icon is visible in your Windows icon tray 

(bottom right area, next to the Windows’ clock). 

If you are collecting online systems data, you should run Monitor in continuous mode.  If 

you are using @ptitude Analyst with multiple hierarchies, it is also recommended to run 

the @ptitude Analyst Monitor application continuously as you may wish to archive 

more than the currently open hierarchy, as is the case with Analyst’s Scheduler 

archives.  Or you may wish to archive specific hierarchy(ies). 

To avoid redundant processing and slowing of hierarchy operations, it is recommended 

to run Monitor on only one machine in a network situation.  If this is the case, run 

Monitor continuously and do not use Scheduler for archiving purposes. 

Monitor – Scheduled Mode 

The Monitor application may also be scheduled to run automatically, as part of a 

scheduled event.  This method is recommended for single users or for use with a single 

hierarchy.  The Scheduler function allows you to run the Monitor on an as-needed 

basis.  For example, you may want to perform Monitor operations based on a certain 

event (after a DAD upload), or under certain circumstances (on a specified day of the 

week, etc.).  

In scheduled mode, the Monitor runs (on the currently open hierarchy only), then shuts 

down when the scheduled task completes.  Refer to the appropriate product specific 

manuals for more information on the Scheduler screen. 

Selecting the Hierarchy to Monitor The Monitor application is able to collect online data 

for one hierarchy at a time.  If necessary, you may change the hierarchy used by 

Monitor.  

To change the @ptitude Analyst hierarchy: 

 Select File / Open from the menu.  The Open Database dialog displays.  The 

hierarchy currently in use is highlighted.  

 If necessary, highlight a different hierarchy and click OK.  Refer to the SKF @ptitude 

Analyst for SKF Multilog On-Line Systems manual for instructions on initiating data 

transfer with the new hierarchy. 
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 If you change hierarchies, data collection on the previously 

selected hierarchy stops.  If you change back to the original 

hierarchy, you must reinitiate data transfer in @ptitude Analyst.  

Monitor Preferences 

Archive 

 

Figure 3 - 1. 

The Monitor Preference Screen’s Archive Tab. 

To set up continuous archiving: 

 Select the Tools menu’s Preferences option.  The Monitor’s Preferences screen 

displays. 

Archive Tab 

 The Archive preference is used in continuous mode only.  
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Enable measurement archive/management archive / management processing - 

Enable to begin the archive processing on the specified hierarchies. 

Select hierarchies to include in archive processing - Lists all hierarchies, allowing 

you to specify which to include in the archive process.   

 Enable the desired hierarchy(ies) to include in archive. 

 By default, all new hierarchies are enabled for Monitor archiving. 

Colors 

 

Figure 3 - 2. 

The Preferences Screen’s Colors Tab. 

All color setting names and their categories appear in the tab.  Each Setting is detailed 

later in this section. 

 Click a Setting to select it.  The Setting’s current color appears in the large color 

box.  The setting’s default color appears in the smaller color box. 

 Click the Default button to restore the setting’s color to the default color. 
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 To change the setting’s color, select a new color from the color menu (colored 

squares at the bottom of the tab). 

 Click the Apply button.  The new color preference setting takes effect immediately. 

 To make all colors revert to their default settings, click the Default All button. 

 Click OK to save changes. 

 Click Cancel to discard changes. 

You may add more cursors and traces for use on plots, and define colors for the new 

cursors and traces.   

Event Log 

 

Figure 3 - 3. 

The Preferences Screen’s Event Log Tab. 
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Purge 

 Click the appropriate button to set your event log purge schedule to Keep all 

events or to Purge events older than your entered number of days.  

Redirect events 

Enter redirect information to transfer your event log details and save them to a host 

computer. 

Port – Select the appropriate port from the drop down list. 

Baud rate – Select the appropriate baud rate from the drop down list. 

Overdue 

Specify how Monitor should process online POINTs that are overdue for collection. 

 These settings only apply to online POINTs. 

Idle time overdue – Specify how often Monitor should check online POINTs to 

determine if they are overdue for collection.   

Overdue factor – Specify how soon after a POINT becomes overdue that an 

overdue event is reported in the Event Log, based on a multiplier of the 

POINT’s collection schedule.  For example, if a POINT is set to collect data every 

four hours, an Overdue factor of 150% will cause an overdue event to be 

triggered if there is no new data for six hours. 
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Appendix A 

SKF @ptitude Analyst Import / Export Features 

Overview 

@ptitude Analyst’s File menu's Import and Export options provide helpful wizards, 

allowing you to: 

Import Analyst data 

Import firmware 

Export Analyst data (MAB) 

Export Analyst data (CSV) 

Each procedure is detailed below. 

Bearing Import Overview 

Bearing files are imported using the Import Analyst Data Wizard.  Reference the Import 

Analyst Data Wizard section later in this chapter for more details. 

@ptitude Analyst Data Import / Export Overview 

The File menu’s Import / Analyst Data and Export / Analyst Data options allow you 

to: 

 Export data from one user’s @ptitude Analyst system and import into another 

user’s @ptitude Analyst system for analysis and review. 

 Export and import data to combine multiple @ptitude Analyst databases into a 

single @ptitude Analyst database. 

 Export a section of a @ptitude Analyst database to another PC or laptop.  Take data 

in the field, upload data to the PC or laptop, then synchronize both databases by 

importing the new data back into the original @ptitude Analyst database. 

 Export industry specific configurations, including Templates and Group Types, to 

other @ptitude Analyst databases. 

IMPORTANT 

Do not use @ptitude Analyst’s Export feature to back up your database.  Data 

necessary for system operation is not included in the export process.  Backups should 

only be performed via the database itself. 

The Analyst Data import and export use wizards to guide you through the process 

(similar to the PRISM4 and Bearing import procedures). The Export Analyst Data 

wizard walks you through up to ten screens to export selected data.  Using the wizard, 
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you select the data to export and specify where the export file is to be stored.  Once all 

export parameters have been specified, the wizard performs the actual export 

processing and provides you with feedback.   

The Import Analyst Data wizard walks you through three screens to identify and 

import @ptitude Analyst data from a data file.  Using the wizard, you select the file to 

import and specify which import options to use.  The wizard performs the import 

processing and provides you with feedback. 

 For a successful import, the system must support all plug-ins 

referenced in the import file.  For example, if the import file 

contains Microlog POINTs, the system performing the import 

must also support the Microlog DAD. 

Import Firmware 

The File menu’s Import / Firmware option allows you to: 

 Import firmware files into @ptitude Analyst for automatic download to the device 

next time a connection is made. 

 The Import Firmware feature is currently only available for the 

IMx device. 

To upload firmware to @ptitude Analyst: 

 Select the File menu’s Import / Firmware option.  The Firmware Manager dialog 

displays.   

 

Figure A - 1. 

The Firmware Manager Dialog. 
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 Click Browse. A file open dialog displays the Firmware directory. 

 Select the firmware file and click Open to import it (upload it to the database). The 

firmware area displays Device, Version, and Publish date / time information for 

the imported firmware. 

 IMx firmware 5.0 or higher requires an IMx preload firmware 

package in the database: 

If you see a message at the bottom of the dialog that the appropriate 

preload file is loaded in the database, then you are ready to import the 

full firmware as described above. 

However, if you see a message at the bottom of the dialog that the 

preload is NOT loaded in the database, you must place the preload file 

into the same directory as the firmware before you can import the 5.0 

or newer firmware: 

 Obtain the preload file and place a copy of it in the software’s 

Firmware directory (this is the same directory the Browse button 

points to by default). 

 Within the Firmware Manager dialog, click Browse. A file open 

dialog displays the Firmware directory. Both the 5.0 or newer 

firmware and the preload file should appear. 

 Click Open to import the 5.0 or newer firmware (upload it to the 

database). As long as the preload file is in the same database, the 

system will load it at the same time as the full firmware file. 

To remove firmware from the database: 

 Select the firmware you wish to remove from the Firmware table. 

 Click Delete. 

 You cannot remove preload firmware packages from the database 

once they have been loaded. 

Export Analyst Data Wizard 

Export Analyst Data Wizard 

The Export Analyst Data wizard walks you through the export process for exporting 

data to MAB and CSV formats. 

 To export analyst data to MAB format, click the File menu’s Export / Analyst data 

(MAB) option. 

 To export analyst data to CSV format, click the File menu’s Export / Analyst data 

(CSV). 

Each export option is detailed below. 
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Export Analyst Data (MAB) 

Export Introduction Screen 

 

Figure A - 2. 

The Export Analyst Data’s Introduction Screen. 

This is the first screen in the Export Analyst Data wizard.  On this screen, specify the 

data to export and the destination file.  The selected data will be exported from the 

database that is currently open. 

Fields on this screen include: 

Export source - Select the hierarchy from which you wish to export data. 

Export destination - Displays the path and filename of the export file to be created.  

Click the Save As button to change the path and filename. 

 By default, the Export destination field contains the path to the 

previously exported file.  If a previous export has not been 

performed, a default path displays. 

Format - Displays the type of file to be written.  The format is determined by the file 

extension.  Currently, only Binary is supported for MAB files. 

The Export Settings area allows you to select the general content types to process 

from Hierarchy data and Shared data.   

Hierarchy data includes Hierarchy, ROUTEs, Workspaces, Templates, and any 

associated data you select to include. 
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Shared data includes global settings that may or may not be currently assigned to 

Hierarchy data items included in the export.  For example, all filter keys associated with 

Hierarchy data items included in the export are automatically exported.  By selecting to 

include Shared data, you may also include specified filter keys that are not currently 

assigned to Hierarchy items included in the export. 

Within each Hierarchy content type, you can set the wizard to use the previously 

selected settings (items selected for export in the last export performed), and skip the 

corresponding screen(s) in the wizard.  This feature allows you to skip one or more 

screens in the wizard sequence if you routinely export using the same settings.  When 

settings from a previous import are available, the appropriate wizard screen checkboxes 

are enabled.  If previous settings are not available for a screen, that wizard screen entry 

appears grayed out. 

 Click the appropriate checkbox(es) to select Hierarchy data, shared data, or both. 

 Click the Next button.  The Hierarchy Source Content screen displays (if you have 

selected to include Hierarchy data in the export).   

 If you have selected to include Shared data only , the wizard 

proceeds directly to the Shared Content screen. 

Hierarchy Source Content Screen 

 

Figure A - 3. 

The Export Analyst Data’s Hierarchy Source Content Screen. 

 top level hierarchy items 
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Use this screen to select which hierarchy items to export.   

 You must select one or more hierarchy items. 

The export content hierarchy tree contains up to five top level items, Hierarchy, 

Workspaces, ROUTEs, Templates, and Transients.  The displayed top level items are 

determined by the items that exist in the currently open database’s hierarchy.  For 

example, if there are no templates in your currently open database, the Template top-

level item will not display in the Export contents hierarchy tree.   

 Use the plus and minus sign icons to expand / contract hierarchy item levels. 

 Use the check boxes to select the desired hierarchy items to include in the export.  

You may select as many items as necessary from any top level item’s hierarchy list.  

For example, you may select items from the Workspace hierarchy list and items 

from the ROUTEs hierarchy list. 

 All selected items are automatically exported with their parent 

item(s).   

 If you select to export a Transient hierarchy item, you must also 

export the related DMx POINTs using the Hierarchy, Workspace, 

or ROUTE item. 

When a top level item is selected (checked), all items beneath that branch are 

automatically included in the export, and a checkmark displays in the top level item’s 

checkbox.  If individual items beneath a top level branch are selected for export, a 

grayed checkmark displays in the top level item’s checkbox indicating that some, but not 

all items beneath this item are to be included in the export. 

 Click the Next button to continue.  The Data Range screen displays (unless you 

have made the appropriate selection on the Export Introduction screen allowing you 

to skip this screen).   

Data Range Screen 

Use this screen to indicate the range of date-based records to include in the export.   

 Once the first export has been performed, Data Range settings 

are stored and will be available the next time you export.  You 

may select to skip this screen in subsequent exports by making 

the appropriate selection on the Export Introduction screen. 

 Options on the Data Range screen include: 

 All records – Select this option to include all records. 

 All records is the default setting. 

Only records within specified date range – Select this option to include records that 

fall within the indicated date range.  Use the From and To text boxes to enter the start 

and end dates to establish your date range.  Only records that have dates corresponding 

to your indicated date range will be included in the export. 

 If you are exporting Transient data, both the start and end date of 

the transient event must fall within this date range to be included. 

Up to the specified number of records per item – Select this option to include a 

specified number of records per item.  Enter the maximum number of records in the 
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Number of items text box.  The specified number of records (if available) will be 

included with each item.  For example, if you enter 5 in the Number of items field, up 

to five records per item are included in the export.  If an item has only three records, 

those three are included.  If an item has seven records, only the first five records will be 

included in the export. 

 By default, the date range displays the current date and the 

number of items is 11. 

 If you are exporting Transient data, this number specifies the 

number of transient data sets.  Each data set includes multiple 

measurements. 

 Click the Next button to continue.  The DAD Selection screen displays (unless you 

have made the appropriate selection on the Export Introduction screen allowing you 

to skip this screen).   

DAD Selection Screen 

Use this screen to select the DAD types to be exported.  Only POINTs of the selected 

DAD type will be exported.  All other POINTs are ignored. 

 You must select a device type. 

 Once the first export has been performed, DAD Selection settings 

are stored and will be available the next time you export.  You 

may select to skip this screen in subsequent exports by making 

the appropriate selection on the Export Introduction screen. 

Important 

The import feature only accepts data for supported DAD types.  Ensure the DAD type 

you select is supported by the software on the destination system.  For example, if the 

system from which you are exporting supports the Microlog DAD type, and you select 

Microlog as your export DAD type, the destination system must also support the 

Microlog DAD type to be able to import the data. 

Items on this screen include: 

Device Type – Displays all supported DAD types.  You can sort the Device Type list in 

ascending or descending order by clicking the column header. 

 Enable a DAD types’ check box to select it.  To select all DAD types, click the Select 

All button.  To clear all selections, click the Clear All button. 

 Click the Next button to continue.  The Hierarchy Setup Content screen displays 

(unless you have made the appropriate selection on the Export Introduction screen 

allowing you to skip this screen).   

Hierarchy Setup Content Screen 

Use this screen to select what additional information to include in the export, along with 

the POINTs and Groups with which the information is associated.  This information 

includes alarm setups, frequency information, images, filter keys, etc.  

 Once the first export has been performed, Hierarchy Setup 

Content settings are stored and will be available the next time you 

export.  You may select to skip this screen in subsequent exports 
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by making the appropriate selection on the Export Introduction 

screen. 

 The inclusion of this additional information is optional.  To 

proceed with the export without including any of this screen’s 

options, click the Next button. 

Items on this screen include: 

Data Type - Displays all available data types.  You can sort the Data Type list in 

ascending or descending order by clicking the column header. 

 Click the items’ checkboxes to include in the export.  To select all items, click the 

Select All button.  To clear all selections, click the Clear All button. 

 Click the Next button to continue.  The Measurement Content screen displays 

(unless you have made the appropriate selection on the Export Introduction screen 

allowing you to skip this screen).   

Measurement Content Screen 

Use the Measurement Content screen to include measurement data attached to the 

POINTs being exported. 

 Once the first export has been performed, measurement content 

settings are stored and will be available the next time you export.  

You may select to skip this screen in subsequent exports by 

making the appropriate selection on the Export Introduction 

screen. 

 The inclusion of measurement data is optional.  To proceed with 

the export without including any measurement data, click the 

Next button. 

Items on this screen include: 

Measurement type – Displays all available measurement data types.  You can sort the 

Measurement Type list in ascending or descending order by clicking the column header. 

 Enable a measurement type’s check box to include in the export.  To select all 

measurement types, click the Select All button.  To clear all selections, click the 

Clear All button. 

 Click the Next button to continue.  The Shared Content screen displays (if you have 

selected to include Shared data). 

Shared Content Screen 

Use the Shared Content screen to select shared data items to include in the export.   

Items on this screen include: 

Include shared data types – Displays all available shared data items.  These items are 

used to configure your database.  Shared data types include alarms, coded notes, 

frequency data, operator names, etc.   

 Use the checkboxes’ plus and minus sign icons to expand / contract the shared data 

type levels. 
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 A plus sign indicates that you may select individual records (if 

available).  For example, you may select a specific envelope alarm. 

 If you also included Hierarchy data items in the export, shared 

data type entries are not required on this screen.  However, if you 

selected to include Shared data types only, you must make at 

least one selection on this screen. 

Important 

The import feature only accepts data for supported data types.  Ensure the data type 

you select is supported by the software on the destination system. 

 Click the items’ checkboxes to include in the export.  To select all items, click the 

Select All button.  To clear all selections, click the Clear All button. 

 Click the Next button to continue.  The Export Review screen displays. 

Export Review Screen 

Use the Export Review screen to review your selections for inclusion in the export.   

Items on this screen include: 

Export settings – Displays all individual settings and setting status. 

Export source – Displays the name of the currently open database. 

Export file – Displays the name of the export file. 

Format – Displays the export file’s format type. 

Save to log file – Displays the status of the log file option.  If enabled, the log 

file “Analyst Export.log” file is created and saved to the same location as the 

export file.  If disabled, a log file is not created. 

Other settings, specific to your current configuration, also display for your review. 

 This screen also displays those settings (if any) automatically 

applied if the option to use previous settings has been enabled, 

and the corresponding wizard screens were skipped. 

 Review the displayed settings carefully.  If all settings are correct, click the Next 

button to proceed with the export.  The Export Process Screen displays. 

If edits are necessary, use the Back button to return to the appropriate screen(s) and 

make changes as necessary.  Click the Cancel button to cancel the export. 

 If the export is cancelled, entered settings are not saved and will 

not be available for the next export. 
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Export Process Screen 

 

Figure A - 4. 

The Export Analyst Data’s Export Process Screen. 

 status information 

 progress bar 

 export status area 

The Export Process screen allows you to begin the export process.   

 Click the Next button to begin the export. 

During the export, the progress bar indicates the export progress.  Export status 

information displays above the progress bar.  Export status information includes the 

number of items processed out of the total number of items to be processed 

(Processing ### of ###).  The Export status: area displays specific information from 

the export, describing what is being processed (this is the same information that is 

saved to the log file, if enabled).   

 When processing is complete, click the Next button to proceed to the Export 

Summary screen. 

Export Summary Screen 

The Export Summary screen displays a summary of the entire export, and allows you to 

finalize the export.  Each exported data type displays, along with the number of records 

exported.   

 Review the summarized information carefully. 

 Click the Finish button to complete the export. 
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 Entered settings are stored and will be available for the next 

export. 

Export Analyst Data (CSV) 

Export Introduction Screen 

 

Figure A - 5. 

The Export Analyst Data’s Introduction Screen (Export to CSV). 

This is the first screen in the Export Analyst Data wizard.  On this screen, specify the 

data to export and the destination file.  The selected data will be exported from the 

database that is currently open. 

Fields on this screen include: 

Export source - Select the hierarchy from which you wish to export data. 

Export directory - Displays the path and filename of the export file to be created.  Click 

the Save As button to change the path and filename. 

 By default, the Export directory field contains the path to the 

previously exported file.  If a previous export has not been 

performed, a default path displays. 

Export file name prefix – Enter a prefix title for the destination file.  The title is a prefix 

to preset filenames. 

Format - Displays the type of file to be written.  The format is determined by the file 

extension.  Currently, only Comma Separated Value (CSV) format is supported. 
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Save processing details to “AnalystExportCSV.log – Enable to save a log file for the 

export. 

 Click the Next button.  The Hierarchy Source Content screen displays.   

Hierarchy Source Content Screen 

 

Figure A - 6. 

The Export Analyst Data Screen. 

  top level hierarchy items 

 

Use this screen to select which hierarchy items to export.   

 You must select one or more hierarchy items. 

The export content hierarchy tree contains up to five top level items, Hierarchy, 

Workspaces, ROUTEs, Templates, and Transients.  The displayed top level items are 

determined by the items that exist in the currently open database’s hierarchy.  For 

example, if there are no templates in your currently open database, the Template top-

level item will not display in the Export contents hierarchy tree.   

 Use the plus and minus sign icons to expand / contract hierarchy item levels. 

 Use checkboxes to select the desired hierarchy items to include in the export.  You 

may select as many items as necessary from any top level item’s hierarchy list.  For 

example, you may select items from the Workspace hierarchy list and items from 

the ROUTEs hierarchy list. 

 All selected items are automatically exported with their parent 

item(s).   
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 If you select to export a Transient hierarchy item, you must also 

export the related DMx POINTs using the Hierarchy, Workspace, 

or ROUTE item. 

When a top level item is selected (checked), all items beneath that branch are 

automatically included in the export, and a checkmark displays in the top level item’s 

checkbox.  If individual items beneath a top level branch are selected for export, a 

grayed checkmark displays in the top level item’s checkbox indicating that some, but not 

all items beneath this item are to be included in the export. 

 Click the Next button to continue.  The Data Range screen displays (unless you 

have made the appropriate selection on the Export Introduction screen allowing you 

to skip this screen).   

Data Range Screen 

Use this screen to indicate the range of date-based records to include in the export.   

 Once the first export has been performed, Data Range settings 

are stored and will be available the next time you export.   

Options on the Data Range screen include: 

All records – Select this option to include all records. 

 All records is the default setting. 

Only records within specified date range – Select this option to include records that 

fall within the indicated date range.  Use the From and To text boxes to enter the start 

and end dates to establish your date range.  Only records that have dates corresponding 

to your indicated date range will be included in the export. 

 If you are exporting Transient data, both the start and end date of 

the transient event must fall within this date range to be included. 

Up to the specified number of records per item – Select this option to include a 

specified number of records per item.  Enter the maximum number of records in the 

Number of items text box.  The specified number of records (if available) will be 

included with each item.  For example, if you enter 5 in the Number of items field, up 

to five records per item are included in the export.  If an item has only three records, 

those three are included.  If an item has seven records, only the first five records will be 

included in the export. 

 By default, the date range displays the current date and the 

number of items is 11. 

 If you are exporting Transient data, this number specifies the 

number of transient data sets.  Each data set includes multiple 

measurements. 

 Click the Next button to continue.  The DAD Selection screen displays.   

DAD Selection Screen 

Use this screen to select the DAD types to be exported.  Only POINTs of the selected 

DAD type will be exported.  All other POINTs are ignored. 

 You must select a device type. 
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 Once the first export has been performed, DAD Selection settings 

are stored and will be available the next time you export.  

Important 

The import feature only accepts data for supported DAD types.  Ensure the DAD type 

you select is supported by the software on the destination system.  For example, if the 

system from which you are exporting supports the Microlog DAD type, and you select 

Microlog as your export DAD type, the destination system must also support the 

Microlog DAD type to be able to import the data. 

Items on this screen include: 

Device Type – Displays all supported DAD types.  You can sort the Device Type list in 

ascending or descending order by clicking the column header. 

 Enable a DAD type’s checkbox to select it.  To select all DAD types, click the Select 

All button.  To clear all selections, click the Clear All button. 

 Click the Next button to continue.  The Measurement Content screen displays.   

Measurement Content Screen 

Use the Measurement Content screen to include measurement data attached to the 

POINTs being exported. 

 Once the first export has been performed, measurement content 

settings are stored and will be available the next time you export.   

 The inclusion of measurement data is optional.  To proceed with 

the export without including any measurement data, click the 

Next button. 

Items on this screen include: 

Measurement type – Displays all available measurement data types.  You can sort the 

Measurement Type list in ascending or descending order by clicking the column 

header. 

 Enable a measurement type’s checkbox to include in the export.  To select all 

measurement types, click the Select All button.  To clear all selections, click the 

Clear All button. 

 Click the Next button to continue.  The Export Review screen displays. 

Export Review Screen 

Use the Export Review screen to review your selections for inclusion in the export.   

Items on this screen include: 

Export settings – Displays all individual settings and setting status. 

Export source – Displays the name of the currently open database. 

Export directory – Displays the destination location of the export file. 

Prefix – Displays the title that will prefix the preset filename. 

Format – Displays the export file’s format type. 
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Save to log file – Displays the status of the log file option.  If enabled, the log 

file “AnalystExportCSV.log” file is created and saved to the same location as the 

export file.  If disabled, a log file is not created. 

Other settings, specific to your current configuration, also display for your review. 

 This screen also displays those settings (if any) automatically 

applied if the option to use previous settings has been enabled, 

and the corresponding wizard screens were skipped. 

 Review the displayed settings carefully.  If all settings are correct, click the Next 

button to proceed with the export.  The Export Process Screen displays. 

If edits are necessary, use the Back button to return to the appropriate screen(s) and 

make changes as necessary.  Click the Cancel button to cancel the export. 

 If the export is cancelled, entered settings are not saved and will 

not be available for the next export. 

Export Process Screen 

 

Figure A - 7. 

The Export Analyst Data’s Export Process Screen. 

 status information 

 progress bar 

 export status area 

The Export Process screen allows you to begin the export process.   

 Click the Next button to begin the export. 
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During the export, the progress bar indicates the export progress.  Export status 

information displays above the progress bar.  Export status information includes the 

number of items processed out of the total number of items to be processed 

(Processing ### of ###).  The Export status: area displays specific information from 

the export, describing what is being processed (this is the same information that is 

saved to the log file, if enabled).   

 When processing is complete, click the Next button to proceed to the Export 

Summary screen. 

Export Summary Screen 

The Export Summary screen displays a summary of the entire export, and allows you to 

finalize the export.  Each exported data type displays, along with the number of records 

exported.   

 Review the summarized information carefully. 

 Click the Finish button to complete the export 

 Entered settings are stored and will be available for the next 

export. 

Import Analyst Data Wizard 

Import Analyst Data Wizard 

The Import Analyst Data wizard walks you through the import process. 

File Verification 

To prevent data from accidentally merging or adding to the wrong hierarchy, @ptitude 

Analyst verifies that the import file belongs to the current hierarchy.  Use the SKF 

@ptitude Analyst Configuration Tool to activate this feature. 

To activate file verification: 

 Open the SKF @ptitude Analyst Configuration Tool. 

 Click SKF @ptitude Analyst Configuration Tool / General Configuration in the 

left pane. 

 From the right pane, browse to Software / SKFConditionMonitoring / 

SKFMachineAnalyst / Import/Export / 

ImportEnforceFilenameHierarchyNameMatch. 

 Set the value data of this key to “1” and save the configuration change. 

The next time you launch the Import Analyst Data wizard, a prompt will display under 

the Import source field (MAB filename) stating “The import source must contain the 

import destination”. 

Unless the selected hierarchy is contained in the MAB filename (for example, the 

hierarchy “Demo” is in the “Demo export.mab” filename), the program will warn you 

when you press Next from the Introduction screen.  The only way to proceed is to 
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change the hierarchy (Import destination) to one that is included in the filename, or 

Browse and select a filename that contains the current hierarchy name. 

Import Introduction Screen 

 

Figure A - 8. 

The Import Analyst Data’s Introduction Screen. 

The Import Introduction is the first screen in the Import Analyst Data wizard.  On this 

screen, select the import source and specify the input processing mode. 

Fields on this screen include: 

Import destination – From the drop down list, select the hierarchy to which you wish to 

import data. 

Import source – Displays the path to the import source file.  Use the Browse button to 

locate the import source file. 

 Click the Save processing details to Analyst Import.log checkbox to enable the 

log file creation.  If enabled, all processing details will be saved to the log file for 

later review.  The log file is saved to the specified import directory. 
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Import processing mode 

Append – Select this processing mode to append all records available in the 

import source file.  Matching records (records that appear in both the import 

file, and are already present on the system performing the import) are 

renamed.  Existing Hierarchy records are not overwritten.  Items are renamed 

with the .1, .2, etc. suffix.  Shared items are renamed if they contain 

parameters that do not identically match those shared items that already exist.  

Use the Append mode to import information without modifying any existing 

setups or shared items.  For example, the append mode is helpful when you 

want to import another operator’s data on your @ptitude Analyst system for 

analysis and review, without modifying your existing data. 

Update – (recommended) Select this processing mode to use the source file 

contents to update existing records as appropriate.  Hierarchy and shared data 

settings merge when matching records exist.  New records are added when 

matching records do not exist.  Use the Update mode to reconfigure items that 

match the newly imported items.  For example, use the update mode when you 

have changed settings on one database and you want to reflect those changes 

in a separate database (such as a laptop). 

WARNING 

Performing this type of import does not completely synchronize databases.  The Export 

Wizard allows custom selection of available options.  Therefore, each export may be 

different.  Unless you have selected to include every available option in the Export 

Wizard, all information is not included in the export.  Deleted and cleared items are 

never included in the export. 

Merge Measurements – Select this processing mode to merge measurement 

data only for existing records.  Only basic hierarchy information is imported for 

new records.  Configuration data and shared data are not imported.  Use the 

Merge Measurements mode to upload measurement data only into an 

existing database.  For example, the merge measurements mode is helpful if 

you are using a laptop to upload data in the field, and you need to transfer the 

measurement data back in to your permanent @ptitude Analyst system later. 

 Click the option button to select the appropriate processing mode. 

 Click the Next button to continue.  The Import Process screen displays. 

Import Process Screen 

The Import Process screen allows you to begin the import process.   

 Click the Next button to begin the import. 

During the import, the progress bar indicates the import progress.  Import status 

information displays above the progress bar.  Import status information includes the 

number of items processed out of the total number of items to be processed 

(Processing ### of ###).  The Import status: area displays specific information from 

the import, describing what is being processed (this is the same information that is 

saved to the log file, if enabled).   

 When processing is complete, click the Next button to proceed to the Import 

Summary screen. 
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Import Summary Screen 

The Import Summary screen displays a summary of the entire import, and allows you 

to finalize the import.  Each imported data type displays, along with the number of 

records exported.   

 Review the summarized information carefully. 

 Click the Finish button to complete the import. 
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Appendix B 

XML Export and Import 

 XML Export and Import feature is available only with the SKF 

@ptitude Analyst CMSW 7400 software. 

Overview 

The XML Export and Import features allow users to share data between SKF @ptitude 

Analyst and other software applications that support the XML data format.  This is 

accomplished by writing hierarchy and measurement information to an external XML 

file, which can then be used to add the information to a hierarchy in the target 

application.  SKF @ptitude Analyst has the ability to both create XML files that can be 

read by other software applications, or import XML files that have been created by other 

software applications. 

Automatic processing of XML files facilitates seamless synchronization of data, including 

SETs, machines, POINTs, and measurement data, between compatible systems. 

 XML Export and Import require a shared drive on the local 

intranet.  The user may need to work with IT personnel to verify 

that any applications exporting or importing XML files are able to 

access and read from / write to the identified directory. 

XML Export 

XML Export creates an XML file containing a specified SKF @ptitude Analyst hierarchy 

and related measurement data in a shared location on the local intranet.  The exported 

file can be used to share data with compatible systems by means of the XML Import 

feature, or with other systems that can process XML files in the @ptitude Analyst XML 

format. 

Using the XML Export feature 

To access XML Export configuration: 

 Select Configure XML Export from @ptitude Analyst’s Customize menu.   

 The XML Export Configuration dialog displays. 
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Figure B - 1. 

The XML Export Configuration Dialog. 

The following fields display: 

Enable Processing – Enables XML export processing in the Transaction Service.  

 This is a global setting that determines whether any XML Export 

processing is performed.  If this is disabled, XML files are not 

created. 

Output Directory – Identifies the shared intranet directory to which the XML files are 

written.  Type the shared directory’s path name in the text entry box or click the Browse 

button to browse for it.  When selecting an output location, ensure that the specified 

directory is accessible to the application that imports the resulting XML files and to the 

host computer running the Transaction Server.  (It is recommended that you grant the 

Everyone group access in Sharing and Security for the folder.) 

 Make sure that the Transaction Server sees the specified directory 

using the same drive mapping and path as entered.  (For 

example, if you enter J:\XMLExport, ensure that the Transaction 

Service also sees the \XMLExport folder in the root of the J:\ 

drive.) 

 The application that performs the import is responsible for 

archiving or purging files from this directory once they have been 

processed.  If the target application does not automatically handle 
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this, a separate process should be put in place by your IT 

department to ensure that older XML files are removed from this 

directory. 

Period (in Hours) – The frequency, in hours, that @ptitude Analyst creates new XML 

files in the specified directory location. This supports intervals of one minute (.017 

hours) or greater. 

Data Links – Lists the file prefix and @ptitude Analyst hierarchy for each XML export 

data link that has been configured.  Each XML export file that should be created is 

defined by a data link. 

Add – Launches the Data Links dialog where you can add XML export data links. (See 

Adding Export Data Links below for details.) 

Modify – Opens the Data Links dialog where you can make changes to the properties of 

the data link that is currently selected in the Links: list.  When you click OK at the Data 

Links dialog after making changes, a new XML file is created using the specified 

properties. 

Remove – Deletes the currently highlighted data link.  The user is asked to confirm the 

decision to delete. 

OK - Saves the settings.   

Cancel - Exits the dialog without saving the changes. 

Help - Launches the context-sensitive help. 

The Transaction Server runs the XML export process in the time increment specified in 

the Period field as long as Enable Processing is marked.  The full structure of the 

hierarchy is contained in the initial XML file that is created when adding the data link.  

Subsequent XML files that are exported contain new measurements that come in, and 

any changes that are made to the structure of the hierarchy. 

Important:  Since only changes are included in the XML files, it is important that all 

exported files are processed by the target application in the order in which they are 

created.   

Adding Export Data Links 

Each XML file that is created during export contains one @ptitude Analyst hierarchy.  If 

you have multiple hierarchies, you can configure a separate data link for each hierarchy 

you would like exported. 

To add an XML Export data link: 

 At the XML Export Configuration dialog, click the Add button. 

 The Data Links dialog displays. 

The following fields display: 

File prefix – Enter the prefix that should be used for XML files created with this data 

link.  When the XML file is created, the file is named with this prefix, followed by the 

creation date and time in the format CCYYMMDDHHMMSS.   
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Example:  

If the file prefix is PLANT01, a file created at 12:30:05 on November 13, 

2007 is named PLANT01_20071113123005.XML. 

Hierarchy – The hierarchy that should be contained in the XML file, defaulting to the 

current hierarchy.  Select the desired hierarchy from the drop-down list.  The resulting 

XML file includes all SETs, machines, and POINTs in the selected hierarchy.  A separate 

data link needs to be created for each hierarchy you would like to export. 

 Click OK to save the data link and create the first XML file containing the structure 

(SETs, Machines, and POINTs) of the specified hierarchy. 

 Historical measurement data is not included in the initial XML file.   

 You are returned to the XML Export Configuration dialog.  The new data link 

appears in the Links: list. 

XML Import 

The SKF @ptitude Analyst XML Import feature allows the user to specify a common 

directory in which various systems periodically store XML data, and allows the @ptitude 

Analyst application to periodically process these import files.   

Functions of XML Import include: 

 Adding new SETs and Machines to @ptitude Analyst 

 Modifying and moving existing @ptitude Analyst SETs and Machines 

 Deleting existing @ptitude Analyst SETs and Machines 

 Adding new POINTs to @ptitude Analyst (including Overall Alarm definitions) 

 Modifying existing @ptitude Analyst POINTs 

 Moving existing @ptitude Analyst POINTs 

 Adding new Overall, FFT, Time, and Phase data 

 Adding event log messages to @ptitude Analyst 

Using the XML Import feature 

To access XML Import configuration: 

 Select the Customize menu’s Configure XML Import option in @ptitude Analyst. 

 The XML Import Configuration dialog displays. 
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Figure B - 2. 

The XML Import Configuration Dialog. 

The following fields display: 

Enable Processing - Enables XML import processing on the Transaction Server.  

 This is a global setting that determines whether any XML Import 

processing is performed.   

Enable Archiving – Enables the archive directory.  If disabled, the archive directory is 

dimmed. 

Input Directory – The shared intranet directory where the XML files to be imported are 

located.  Type the shared directory’s path name in the text entry box or click the browse 

(…) button to browse for it.  When selecting an input location, ensure that the specified 

directory is accessible to host computer running the Transaction Server.  (It is 

recommended that you grant the Everyone group access in Sharing and Security for the 

folder.)  Also ensure that the Transaction Server sees the specified directory using the 

same drive mapping and path as entered.  (For example, if you enter J:\XMLImport, 

ensure that the Transaction Server also sees the \XMLImport folder in the root of the 

J:\ drive.) 

 If you are using XML files created via the @ptitude Analyst XML 

Export feature, this is the directory specified in the Output 

Directory field in the XML Export Configuration dialog. 
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Warning:  

XML Import processes all files found in this directory and purges any files that are 

not valid import files.  The selected directory should only be used for XML Import, 

and only for files that should be processed from this @ptitude Analyst installation.  

If you have multiple @ptitude Analyst systems that require XML Import, they should 

each use a unique directory location.  

Archive Directory (if specified) - The directory where processed files are stored.  Type 

the directory’s path name in the text entry box or click the browse (…) button to browse 

for it.  Once an XML file has been processed, it is moved from the Input Directory 

location to the Archive Directory.  When selecting an archive location, ensure that the 

specified directory is accessible to host computer running the Transaction Server and 

that the path information is valid on that computer.   

 Confirm a periodic cleanup function is in place on the host 

computer to ensure that the archiving of data does not result in a 

disk full condition.  

Period (in Hours) - The frequency that the @ptitude Analyst application checks for new 

XML import files. This supports intervals of one minute (.017 hours) or greater. 

Data Links - Lists the XML file prefix and @ptitude Analyst hierarchy for each import 

data link that has been added.  Each data link stores data supplied by the external XML 

system that is identified by the specified file prefix in the designated @ptitude Analyst 

hierarchy. 

Add - Launches the Data Links dialog where you can add XML Import data links.  (See 

Adding Import Data Links, below, for details.) 

Modify - Allows the user to modify any existing highlighted link. 

Delete - Allows the user to delete any existing highlighted link. The user will be asked to 

confirm the deletion. 

OK - Saves the settings, acts as a “Process Now” function, and resets the time of next 

processing to Now + Period.   

Cancel - Exits the dialog without saving the changes. 

Help - Launches the context-sensitive help. 

The Transaction Server runs the XML import process in the time increment specified in 

the Period field as long as Enable Processing is marked.  It checks the Input Directory 

file location for new XML files with the specified prefix.  If a file is found, the XML data is 

written to the specified @ptitude Analyst hierarchy and the XML file is archived (if 

selected) and purged from the input directory. 

 There is a 2 GB file size limit for XML import files. 

 If a POINT added by XML Import was originally created on a 

Microlog Data Acquisition Device, you will have full access to 

POINT Properties.  If an XML Import POINT originated from any 

other source, you will be able to view, but not edit, most 

properties. 
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Adding Import Data Links 

To add an XML Import data link: 

 At the XML Import Configuration dialog, click the Add button. 

 The Data Links dialog displays. 

The following fields display: 

File Prefix – The prefix of the files supplied by the XML source file data provider. 

 @ptitude Analyst expects XML files to be named with the specified 

prefix, followed by the date and time the file was created in the 

format CCYYMMDDHHMMSS.   

Example:  

If the XML system produces files named 

MINE01_20070505120005.XML, the prefix is “MINE01_” and the file 

was generated on May 5th, 2007 at 12:00:05. 

Hierarchy – The @ptitude Analyst hierarchy into which data should be written.  Select 

the desired hierarchy from the drop down list (the user should have hierarchies defined 

using the File / New command in @ptitude Analyst). 

Click OK to save the data link and return to the XML Import Configuration dialog.  The 

new data link appears in the Data Links list. 
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Appendix C 

SKF @ptitude Analyst Keyboard Support 

General Keyboard Support 

F2 

Causes selected item to enter “rename” mode. 

ESC 

Cancels (escapes from) the current mode (rename mode, etc.). 

Delete 

Deletes the selected item (and its children).  A prompt follows to confirm deletion. 

Insert 

Opens the Insert dialog corresponding to the selected item. 

Hierarchy, Workspace, ROUTE, and Template Window Keyboard Support 

Numeric keypad’s “plus” key (+) 

Expands the selected item. 

Numeric keypad’s “minus” key (-) 

Collapses the selected item. 

Numeric keypad’s asterisk key (*) 

Expands all items beneath the selected item. 

Ctrl and numeric keypad’s asterisk key (*) 

Collapses the selected hierarchy branch and all its children. 

Right arrow key () 

Expands the selected item and navigates down to the child level 

Left arrow key () 

Collapses the selected item and navigates up to the parent level. 

Up () and Down () arrow keys 

Navigate up and down in the list. 
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Alarms Window Keyboard Support 

Tab 

Moves window focus (active area) between the Alarms for field and the listed items 

area. 

Up () and Down () arrow keys 

Navigate up and down in the listed items area. 

Plot Window Keyboard Support 

See also Appendix D, Plot Icons and Hot Keys. 

Tab 

Moves window focus (active area) between individual plots, tabs, and tabs’ data areas. 

Left and right arrow keys ()  () 

Moves window focus (active area) from tab to tab. 

Up () and Down () arrow keys 

Navigate up and down in the selected tab’s data area. 

I Key 

Toggles the information window on and off. 

Overlay Keyboard Support 

Overlay keystrokes affect the active overlay only (identified by the square icon).  General 

overlay keyboard support is overviewed below.  For more information on an individual 

overlay’s keyboard support, refer to the Overlay Types section the product-specific user 

manuals. 

Left and right arrow keys ()  () 

Move the active overlay left and right. 

Shift and left and right arrow keys ()  () 

Moves the active overlay in larger increments. 

Ctrl and left and right arrow keys ()  () 

Moves the active overlay in smaller increments. 

Page Up and Page Down 

Cycles through the different portions of the active overlay, making different portions 

active for movement. 

Enter 

Toggles between traces when the plot is displaying more than one trace. 
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Delete 

Deletes overlay from plot. 

Orbit Keyboard Support 

F2 key  

Toggle Compensation ON / OFF 

F3 key 

Toggle through 1x, 2x, 3x Orbit filters 

F4 key 

Toggle through number of revolutions (1,2,3,5) 

Bode Keyboard Support 

F2 key  

Toggle Compensation ON / OFF 

Nyquist Keyboard Support 

F2 key  

Toggle Compensation ON / OFF 

Spectrum Keyboard Support 

A key 

Switch to Acceleration 

D key 

Switch to Displacement 

K key 

Toggle Lin/Log X axis 

L key 

Toggle Lin/Log Y axis 

Q key 

Toggles X axis frequency Hz, frequency CPM, and orders 

V key 

Switch to Velocity 

X key 

Turns on Diagnostics 
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Envelope Alarm Editing Keyboard Support  

F5 key 

Initiates edit mode.  

F6 key 

Generates a  new envelope alarm.  

F7 key 

Sets the frequency range.  

Esc key 

Ends edit mode. If data was modified, you will be prompted to save your changes or 

undo your changes.  

Ins key 

Toggles keyboard drawing  on / off.  

Up arrow key 

Moves the edit cursor up 10% from the current amplitude position.  

Down arrow key 

Moves the edit cursor down 10% from the current amplitude position.  

Left arrow key 

Moves the edit cursor one space to the left.  

Shift + Left arrow key 

Moves the edit cursor fifteen spaces to the left.  

Right arrow key 

Moves the edit cursor one space to the right.  

Shift + Right arrow key 

Moves the edit cursor fifteen spaces to the right.  

 



 

SKF @ptitude Analyst Introduction  D - 1 

User Manual 

Appendix D 

Plot Icons and Hot Keys
Category Hot Key Description 

Common Hot Keys 

  Delete  Remove current overlay 

  Alt Up/Down 

 

Previous/next point 

  Alt Shift Up/Down 

 

Previous/next measurement (timestamp) 

 
Text Annotation Overlay 

  Left/Right/Up/Down 

 

Move textbox 1 step left/right/up/down 

  Shift Left/Right/Up/Down 

 

Enlarge textbox left/right/up/down boundary 

  Ctrl Left/Right/Up/Down 

 

Reduce textbox left/right/up/down boundary 

 
Bode Plot 

 
Damping Cursor Overlay Left/Right  Move cursor to previous/next measurement 

 
Single Cursor Overlay Left/Right  Move cursor to previous/next measurement 

 
Cascade Plot 

 
Band Cursor Overlay 

Left/Right  
Move band 1 step left/right 

Move cursor 1 step left/right (after Page Up/Page Down) 

Shift Left/Right  
Move band macro step left/right 

Move cursor macro step left/right (after Page Up/Page Down) 

Page Up/Page Down 

 

Select the left/right boundary cursor of band 

 
Harmonic Cursor Overlay 

Left/Right  Move range 1 step left/right 

Shift Left/Right  Move range macro step left/right 

Up/Down 

 

Previous/next measurement 

 
Single Cursor Overlay 

Left/Right  Move range 1 step left/right 

Shift Left/Right  Move range macro step left/right 

Up/Down 

 

Previous/next measurement 

 
HAL Trend Plot 

 
HAL Alarm Overlay Up/Down 

 

Select a different frequency  

 
Single Cursor Overlay Left/Right  Move cursor to previous/next measurement 

 
Previous (shown here) and 

Next Frequency 

Add/Subtract (must use 

numeric keyboard)  Display previous/next frequencies item 

 
Inspection Plot 

 
Inspection Cursor Overlay Left/Right  Move cursor to previous/next measurement 

 
Notes No Hot Key 
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Category Hot Key Description 

 
Mag/Speed Plot 

 
Linear Speed Overlay Left/Right  Move cursor to previous/next measurement 

 
Overall Alarm Overlay No Hot Key 

 
 

 
Single Cursor Overlay Left/Right  Move cursor to previous/next measurement 

 
MCD Plot 

 
MCD Alarm Overlay No Hot Key 

 
 

 
MCD Cursor Overlay Left/Right  Move cursor to previous/next measurement 

 
MCD Curve Fit Overlay No Hot Key 

 
 

 
MCD Notes No Hot Key 

 
 

 
Nyquist Plot 

 
Single Cursor Overlay Left/Right  Move cursor to previous/next measurement 

 
Orbit Plot 

 
Band Cursor Overlay 

F2  Changes slow roll compensation 

F3  Changes filtering option 

F4  Changes number of revolutions 

 
Linear Speed Overlay No Hot Key 

 
 

 
Single Cursor Overlay 

Left/Right  Move cursor 1 step left/right in Time Plot 

Shift Left/Right  Move cursor macro step left/right in Time Plot 

 
Polar Vector Plot 

 
Phase Alarm Overlay No Hot Key 

 
 

 
Single Cursor Overlay Left/Right  Move cursor to previous/next measurement 

 
Shaft Centerline Plot 

 
Bearing Clearance Overlay No Hot Key 

 
 

 
Single Cursor Overlay Left/Right  Move cursor to previous/next measurement 

 
Spectrum Plot 

 
Band Alarm Overlay 

Add/Subtract (must use 

numeric keyboard)  Display previous/next band 

 
Band Cursor Overlay 

Left/Right  
Move range 1 step left/right 

Move cursor 1 step left/right (after Page Up/Page Down) 

Shift Left/Right  
Move range macro step left/right 

Move cursor macro step left/right (after Page Up/Page Down) 

Page Up/Page Down 

 

Select the left/right boundary cursor of band 

 
Diagnostics Overlay 

X  Display diagnostic cursor 

Up/Down 

 

Display previous/next pattern 

 

Envelope Alarm 

Overlay 

F5  Start editing mode 

F6  Generate envelope alarm 

F7  Set alarm frequency 

Esc  Save 

Insert  Initiate edit mode 

Left/Right/Up/Down 

 

Move edit cursor 

 
Frequencies Overlay 

Add/Subtract (must use 

numeric keyboard)  Display previous/next frequencies item 
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Spectrum Plot (continued) 

 
Harmonic Cursor Overlay 

Left/Right  Move cursor 1 step left/right 

Shift Left/Right  Move cursor macro step left/right 

Ctrl Left/Right  Move cursor micro step left/right 

 
Linear Speed Overlay No Hot Key 

 
 

 
Peak Cursor Overlay 

Up/Down 

 

Move Amp 1% up/down 

Shift Up/Down 

 

Move Amp 10% up/down 

 
Running Speed Overlay No Hot Key 

 
 

 
Sideband Cursor Overlay 

Left/Right  Move cursor 1 step left/right 

Shift Left/Right  Move cursor macro step left/right 

Ctrl Left/Right  Make delta smaller/larger 

 
Single Cursor Overlay 

Left/Right  Move cursor 1 step left/right 

Shift Left/Right  Move cursor macro step left/right 

 
Spectrum Waterfall Plot 

 
Band Cursor Overlay 

Left/Right  
Move band 1 step left/right 

Move cursor 1 step left/right (after Page Up/Page Down) 

Shift 

Left/Right  
Move band macro step left/right 

Move cursor macro step left/right (after Page Up/Page Down) 

Page Up/Page Down 

 

Select the left/right boundary cursor of band 

 
Single Cursor Overlay 

Left/Right  Move band 1 step left/right 

Shift 

Left/Right  Move band 15 steps left/right/previous/next spectrum 

Up/Down 

 

Previous/next measurement 

 
Time Plot 

 
Band Cursor Overlay 

Left/Right  
Move range 1 step left/right 

Move cursor 1 step left/right (after Page Up/Page Down) 

Shift Left/Right  
Move range macro step left/right 

Move cursor macro step left/right (after Page Up/Page Down) 

Page Up/Page Down 

 

Select the left/right boundary cursor of band 

 
CTA Cursor Overlay 

Left/Right  
Move range 1 step left/right 

Move cursor 1 step left/right (after Page Up/Page Down) 

Shift Left/Right  
Move range macro step left/right 

Move cursor macro step left/right (after Page Up/Page Down) 

Ctrl Left/Right  
Move range 2 steps left/right 

Move cursor 2 steps left/right (after Page Up/Page Down) 

Ctrl Shift Left/Right  
Move range micro step left/right 

Move cursor micro step left/right (after Page Up/Page Down) 

Page Up/Page Down 

 

Select the left/right boundary cursor of band 
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Category Hot Key Description 

 
Time Plot (continued) 

 
Harmonic Cursor Overlay 

Left/Right  
Move range 1 step left/right 

Move cursor 1 step left/right (after Page Up/Page Down) 

Shift Left/Right  
Move range macro step left/right 

Move cursor macro step left/right (after Page Up/Page Down) 

Ctrl Shift Left/Right  
Move range micro step left/right 

Move cursor micro step left/right (after Page Up/Page Down) 

Page Up/Page Down 

 

Select the left/right boundary cursor of band 

 
Linear Speed Overlay No Hot Key 

 
 

 
Peak Cursor Overlay 

Up/down 

 

Move Amp 1% up/down 

Shift Up/Down 

 

Move Amp 10% up/down 

Left/Right  Move cursor 1 step left/right 

Shift Left/Right  Move cursor macro step left/right 

 
Topology Plot 

 
Single Cursor Overlay 

Left/Right  Move cursor 1 step left/right 

Shift Left/Right  Move cursor macro step left/right 

Up/Down 
 

Previous/next measurement 

 
Trend Plot 

 
Curve Fit No Hot Key 

 
 

 

Exponential 

Curve Fit 
No Hot Key 

 
 

 
Linear Speed Overlay Left/Right  Move cursor to previous/next measurement 

 
Notes No Hot Key 

 
 

 
Oil Analysis Left/Right  Move cursor to previous/next measurement 

 
Overall Alarm No Hot Key 

 
 

 
Running Speed Overlay Left/Right  Move cursor to previous/next measurement 

 
Single Cursor Overlay Left/Right  Move cursor to previous/next measurement 

 
Protection Threshold Overlay Left/Right  Move cursor to previous/next measurement 
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Index 

A 

access levels 2-50 

acknowledge alarm 

preference 2-60 

acknowledge alarms 2-28 

administrative setup 2-46 

administrator 2-46, 2-48 

alarm details 2-29 

alarm status indicators 2-6 

alarms window 2-27 

acknowledge alarm 2-28 

analyst 2-48 

auto link 2-7 

auto link enabled 

preference 2-55 

B 

bearing import A-1 

C 

cancel command button 2-11 

check boxes 2-13 

cloned group message 

preference 2-56 

command buttons 2-13 

configuration log 2-59 

contact information 2-41 

contact groups 2-45 

individual contacts 2-42 

control menu box 2-3 

custom group type 2-6 

customize menu 2-17 

D 

delete 2-10 

demo database 2-46 

dialogs 2-12 

dimmed options 2-11 

E 

edit menu 2-14 

ellipsis 2-12 

event log 2-32 

edit event log filter dialog 2-35 

filtering 2-34 

exit 2-14, 2-82 

export 

XML B-1 

F 

FFT spectrum 

preferences 2-74, 2-80 

file menu 2-14 

find 2-14 

Firmware Manager A-2 

frequency units 

preference 2-56 

G 

group 2-5 

H 

help menu 2-17 

help, on-line 2-11 

hierarchy 2-5 

multiple 2-5 

hierarchy list 2-5 

hierarchy window 2-18 

host computer 1-4 

I 

import 

bearing A-1 

XML B-4 

Import firmware A-2 

IMx 

post-processing 2-59 

initial log in 2-1 

insert 2-10 

insert menu 2-16 

K 

keyboard controls 2-10 

keyboard support 

alarms window C-2 

envelope alarm editing C-4 

general C-1 

main windows C-1 

overlays C-2 
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plot window C-2 

L 

list boxes 2-13 

log in, initial 2-1 

M 

machine 2-6 

machine priority color 

preference 2-56 

maximize button 2-3 

maximized mode 

preference 2-56 

measurement data record 2-7 

measurement point 2-6 

measurement precision 

preference 2-56 

menu bar 2-3 

minimize button 2-3 

monitor 

continuous mode 3-2 

overview 3-1 

preferences 3-3 

recovery service 3-1 

scheduled mode 3-2 

select hierarchy 3-2 

monitor window 3-1 

mouse 2-10 

N 

next / previous measurement button 2-7 

next / previous POINT button 2-7 

O 

ok command button 2-11 

operator 2-48 

option buttons 2-13 

P 

password 2-47 

paste multiple 2-14 

plot window 2-29 

point 2-6 

preferences 

color display 2-63 

general 2-54 

global 2-58 

measurement 2-61 

plot display 2-68 

WMx non-collection 2-80 

R 

restore button 2-3 

route 2-7 

route window 2-19 

S 

save button 2-11 

security 2-2 

send messages 2-41 

set 2-6 

support, technical 1-3 

system information view 2-31 

alarm details 2-31 

measurement details 2-31 

T 

technical support 1-3 

technician 2-48 

template window 2-25 

text boxes 2-13 

title bar 2-3 

toolbar 2-3 

transfer menu 2-16 

trend/notes 2-75 

U 

undo button 2-11 

user name 2-47, 2-48 

V 

view data HMI operator 2-48 

view menu 2-16 

W 

window 

frame 2-4 

window layout 2-8 

window menu 2-17 

work notifications 3-1 

working area 2-4 

workspace 2-7 
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X 

XML export B-1 

XML import B-4 
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